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CHAPTER 1

Web Weaver

This chapter will discuss the capabilities of Web Weaver as well as Web Weaver's
interface.

• What is Web Weaver and what does it do?
• the Web Weaver window
• the Menu Bar
• the Button Bar
• the File List
• the Status Bar
• right mouse button capabilities
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What does Web Weaver do?

Web Weaver is a comprehensive, feature-rich HTML text editor for Windows which makes it easy to
create Web pages. Web Weaver is a powerful editor which is ideal for beginners as well as advanced users
of HTML.

Web Weaver features:

- Frames, Tables and Forms are all supported by Web Weaver. It includes easy to use wizards for
creating these advanced HTML elements.

- All HTML 2, 3.2 and 4.0 tags are supported.

- Easy-to-use toolbars which automate repetitive keyboard input (such as <P>, <BR>)

- Intuitive dialog boxes for the insertion of hypertext, inline images, anchors, lists, etc.

- Context-sensitive help with a great HTML reference covering HTML 2 and 3 specifications.

- Netscape and Internet Explorer HTML Extensions are included.

- Links to a specified browser at the push of a button. This allows the user to view their document.

- Strip HTML tags from a document by pushing the strip button. This results in the creation of a text
document with HTML tags removed.

- Easily convert existing lists and delimited text(from Excel spreadsheets, etc.) to HTML files.
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The Web Weaver window

Web Weaver has an easy-to-use interface which consists of a Title Bar, Menu Bar, Button Bar, File List
(windows 95/98/NT version only), a Document Window, and a Status Bar. These elements are shown in
the picture below.

The Menu Bar

The Menu Bar contains all of Web Weaver's commands that help you create HTML documents. These
commands are broken down into the following categories:
Option Description
File The File menu includes commands for opening, closing, saving,

printing, importing and exporting files. It also contains commands that
allow you to insert a file into the current file and lists the most recently
opened files so that you can quickly open them.

Edit The Edit menu includes commands that allow you to modify your
document. These commands allow you to cut, copy and paste text
within your document. If you make a mistake you can Undo the last
edit that you made to the document. You can also modify existing
HTML tags in the document, find and replace text within the document.

Insert The Insert menu is the central menu you use for creating your HTML
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document. It allows you to insert all supported HTML tags into your
document such as: Structure tags, Paragraph tags, Physical Style tags,
Logical Style tags, Special HTML characters, Hyperlinks, Images and
many others. It also gives you access to commands for starting wizards
to help you create HTML Forms, Tables and Frames.

Format The Format menu includes commands for changing the look and style of
the text in the HTML document (when it is displayed in a browser).
The font style, size, color and physical style can be set using this
command.

View The View menu includes commands for setting Web Weaver's
preferences, viewing the file properties of the currently opened HTML
document, and for previewing your Web page with 2 different browsers.

HTML Extensions The HTML Extensions menu includes commands for inserting Netscape
and Internet Explorer-specific HTML tags that are not included in the
HTML specification. These are proprietary HTML tags recommended
by Netscape and Microsoft which are supported by most browsers (but
not all).

Tools The Tools menu includes commands for accessing Web Weaver's
advanced functions and common applications. You can access Web
Weaver's HTML Stripper, Spell checker, Site management tool and
Web page statistics tool(Gold version only), Refreshing the HTML
syntax colors in Web Weaver's Document window, and open other
applications such as an FTP client and any Graphics application.

Window The Window menu includes commands that allow you to rearrange
icons and windows. It also lists the document windows that are open
and includes a command that allows you to close all document windows
at once.

Help The Help menu includes commands that open Web Weaver's main help
file. Also, there are tutorials, how-to's and a beginner's wizard that can
be accessed from this menu.

The Button Bar
Web Weaver has a Button Bar which includes buttons for commonly used commands. Using the Button
Bar will improve the speed at which you create and edit HTML documents. The following list describes
the various buttons.
Button Description Button Description

Create a new HTML document Open an Existing HTML
document.

Save the current document. Print the current document.
Cut the selected text and put it on the
clipboard.

Copy the selected text to
the clipboard.
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Paste the clipboard text to the current
document.

Open the FTP Client.

Open the graphics application. Select a color from the
color picker.

Set the document’s page properties. Insert a hyperlink

Insert an image Insert an anchor

Start the Frame wizard. Preview the current HTML
document in browser #1

Preview the current HTML document in
browser #2

Refresh the document’s
colored syntax (text)

Search for text. Spell checker.
Changes the selected text to boldface. Changes the selected text to

an italic font.
Changes the selected text to an underlined
font.

Sets the font style of the
selected text.

Sets the selected text to heading 1 size (large
font).

Sets the selected text to
heading 2 size.

Sets the selected text to heading 3 size Sets the selected text to
heading 4 size.

Sets the selected text to heading 5 size Sets the selected text to
heading 6 size (small font)

Inserts a paragraph tag into the document Inserts a line break tag into
the document

Inserts a horizontal rule into the document Aligns the selected text
flush left.

Centers the selected text Aligns the selected text
flush right

Indents the selected text Inserts a comment into the
document

Starts the Table wizard Inserts a Table tag into the
document

Inserts a Table Row tag into the document Inserts a Table Header tag
into the document

Inserts a Table Data tag into the document Starts the Form wizard

Inserts a Form Textbox Inserts a Form TextArea

Inserts a Form Checkbox Inserts a Form Radio
button

Inserts a Form Pulldown menu Inserts a Form image

Inserts a Form Submit button Inserts a Form Password
textbox

Starts the Bulleted List wizard Starts the Numbered List
wizard

Starts the Descriptive List wizard Inserts Bulleted List tags
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Inserts Numbered List tags Inserts Descriptive List
tags

Inserts List item tag

The File List
Web Weaver for Windows 95/98/NT includes a File List on the right side of the main window. The File
List is used for:
• Opening HTML documents in Web Weaver by doubleclicking on the filename
• Inserting a hyperlink in the current document by dragging and dropping the selected file in the File List
• Performing file operations such as renaming, copying, moving and deleting files (right mouse-click

event)
• Checking links within the selected file (right mouse-click event)
• Viewing File properties of the selected file (right mouse-click event)

The Status Bar
Web Weaver’s status bar at the bottom of the Web Weaver window notifies you of any activity going on in
Web Weaver. It also lists the current time, the size of the current document (in bytes), the line number of
the current cursor location, and if the CAPSLOCK and Insert functions are enabled.
Double-clicking on the time display in the Status Bar will insert the current date and time into the current
document.

Right mouse-button capabilities
Using your right mouse-button in Web Weaver is very useful. You can click the right-mouse button in the
following areas of the Web Weaver window and perform the following functions with the pop-up menus:
Web Weaver window area Function
Document window Click the right mouse-button and the Edit pop-

up menu will appear allowing you to perform
the same commands that are found in the Edit
menu.

File List Click the right-mouse button and the pop-up
menu will allow you to choose commands for
modifying the files in the File List. Rename,
copy, move, delete, file properties, check links,
and open files are available commands in this
menu.
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CHAPTER 2

Web Weaver Menus

This chapter will discuss Web Weaver's Menu Bar and commands.

• File menu
• Edit menu
• Insert menu
• Format menu
• View menu
• HTML Extensions menu
• Tools menu
• Window menu
• Help menu
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Menu Bar Commands

Listed below are the main menu items in Web Weaver's Menu Bar.

• File Menu Page 11
• Edit Menu Page 12
• Insert Menu Page 13
• Format Menu Page 14
• View Menu Page 14
• HTML Extensions Menu Page 17
• Tools Menu Page 18
• Window Menu Page 19
• Help Menu Page 20

File Menu

The File Menu contains commands for file operations such as opening files, saving files and printing files.

New
This opens a new document window for editing your HTML document. The new document
window can be a blank sheet with no text on it OR you can start it with the Web Weaver Starter
template. This starter template inserts the HTML tags which begin every HTML document so you
don't have to type them in every time you create a new Web page. The new document button gives
you the starter template.

Open
This displays the “Open File” dialog box and allows you to open an existing text, HTML
document, or a user-defined template.

Open file from the Web
This displays the “Open File from the Web” dialog box and allows you to open an existing Web
page directly from the World Wide Web.

Simply type the URL of the Web page into the inputbox labeled ‘Enter Web page URL:’ and click
OK. The Web page will be downloaded from the Web and will appear in Web Weaver. You can
also use the ‘Browse Internet Explorer Favorites’ button to search for your favorite Web pages.

Close
This closes the current document, and it will prompt you to save the document if any changes have
been made to it.

Insert File
This inserts a specified text/HTML file into the current document starting at the location of the
cursor.
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Import/Export - Open and Save As UNIX format
This allows you to open a document which has been saved in the UNIX format and save the
current document as an HTML file in UNIX format (without carriage returns).

Import/Export - Open and Save As Mac format
This allows you to open a document which has been saved in the Mac file format and save the
current document as an HTML file in Mac format (without line feeds).

Save
This saves the current document with its current name.

Save As
This allows you to save the current document as a file with the same or a different name.

Print
This prints the current document.

Recent File List
The recent file list shows the files that were most recently opened in Web Weaver. This makes it
easy to open a document that you frequently work on. Up to 10 files can be displayed.

Exit
This exits the program, and it will prompt you to save any document if any changes have been
made.

Edit Menu

The Edit Menu contains commands for editing the HTML document such as cutting, copying and pasting
text as well as finding and replacing text in the HTML document.

Undo
This un-does the last action you performed on the active document.

Edit Tag
Placing your cursor inside an HTML tag in your document and selecting this menu item results in
Web Weaver displaying the dialog box associated with the selected HTML tag so that you can edit
the existing attributes of that tag. Not all tags are supported by this command.

Cut - Shortcut Key: CTRL-X
This cuts the selected text from the document and puts it in the Windows clipboard.

Copy - Shortcut Key: CTRL-C
This copies the selected text from the document and puts it in the Windows clipboard.

Paste - Shortcut Key: CTRL-V
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This inserts the contents of the Windows clipboard into the Web Weaver text area at the position
of the cursor.

Select All - Shortcut Key: CTRL-A
This selects all text in the currently opened HTML document.

Find
This opens the Find dialog box which aids in locating specified text.

Find Next - Shortcut Key: F3
Selecting this from the menu or pressing F3 will result in locating the next instance of the text
string that was previously specified in the Find dialog box.

Replace
This opens the Replace dialog box which allows the user to find a specified text string in the
document and replace it with another specified text string.

Global Find and Replace(click here for more)
This opens the Global Find and Replace dialog box which allows the user to find a specified text
string in multiple documents and replace it with another specified text string.

Word Wrap
This enables and disables word wrap in the current document.

Insert Menu

The Insert menu contains commands for inserting HTML tags into the HTML document. Most of the
HTML tags are found under this main menu item.

• Page Properties
• Structure Tags
• Paragraph/Text Elements
• Logical Style Tags
• Physical Style Tags
• Special Characters

• Anchor /Bookmark
• Email Link
• HyperLink
• Horizontal Line
• Image
• Sound/Multimedia Object
• Lists
• Table

• Form Wizard
• Frame Wizard
• ImageMap Wizard
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• Table Wizard

• Date and Time

Format Menu

The Format menu allows you change font settings of selected text.

View Menu

The View menu allows you to view and change Web Weaver's preferences and to view the current HTML
document's file properties. The Preferences dialog box controls certain environment variables such as:

GENERAL SETTINGS

Web page folder:Web Weaver will automatically open this folder when you are trying to open or
save a file.

Image folder: Web Weaver will automatically open this folder when you are trying to insert an
image.

Screen font and size:Web Weaver will use this font and font size for the main editing window’s
screen font.

Show the Tip of the Day at startup: You can turn the Tip of the Day on and off..

Word Wrap: You can set your documents to automatically word wrap with this setting.

Cascade documents when opening them :This causes documents to cascade when opening them.
The default setting is for documents to maximize when Web Weaver opens them.

Show Page Properties dialog box for each new document:When you start a new document, the
Page Properties box appears to allow you to set page colors, title, etc. Uncheck this checkbox to
stop the Page Properties dialog box from appearing for each new document.

Open new document on startup:Web Weaver automatically opens a blank/new document when
you start. Uncheck this checkbox and Web Weaver will start with no open documents.

Open most recently used document on startup:Web Weaver automatically opens the document
you were working on when you last used Web Weaver.

Start new documents with a blank page:Web Weaver automatically uses a standard HTML
template when starting a new document. Check this checkbox to force new documents to be blank.
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Use Beginner Table Wizard:You have the option of using the Beginner table wizard in Web
Weaver or using the advanced wizard. The Beginner wizard takes you step by step through the
creation of a table. The advanced Wizard allows you to quickly input table properties without all
the explanations and step-by-step procedures.

Show properties box when inserting <HR> Horizontal Line:By default, Web Weaver opens the
Horizontal Line properties box when inserting a horizontal line. This setting allows you to turn
this option off.

Number of files on the Most Recently Used File list:Specify the number of most recently used
files that you want to appear on the File menu. The default is 4.

Show File List: By default, Web Weaver displays the File List on the left or right side of the main
Web Weaver window. Uncheck this checkbox to hide the File List.

Align File List on left side: By default, Web Weaver aligns the File List on the right side of the
screen. Check this checkbox to align the File List on the left side of the screen.

PREVIEWERS/APPLICATIONS

Browser #1: The path and filename of your browser should be declared so Web Weaver will know
where to look when opening it to view your HTML document. The default browser on your
computer is used for Browser #1 unless you choose to override this setting and specify your own
browser.

Browser #2: Similar to Browser #1 setting. This allows you to preview your Web pages with a
second browser of your choice.

Graphics Application settings: Insert the path/filename of your Image Editing program so Web
Weaver can open it for you from the Tools menu.

FTP Client settings: Insert the path/filename of your FTP Client so Web Weaver can open it for
you from the Tools menu.

CUSTOM BUTTONS

Toolbox(Win 3.1 version) and custom buttons(Win 95 version):This opens or closes the
toolbox window which has buttons available for user defined HTML macros to make HTML tag
insertion a little more user friendly. The Toolbox settings dialog box controls these user-defined
buttons.

FAVORITE URLS
The Favorite URLs settings box allows the user to input frequently used Web addresses (URLs) to
allow easier insertion of these addresses instead of typing them in each time. The hypertext and
image dialog boxes use the Favorite URLs pull-down boxes for easy input.
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MENU SYSTEM

The Menu System settings box allows the user to choose an appropriate Web Weaver menu system
for their degree of HTML knowledge. There are many HTML tags that you will never use. This
gives the user an opportunity to select Minimum, Typical, Maximum or Custom menus depending
on their HTML knowledge. The Custom menu system allows the user to pick and choose which
menu items he/she would like to be available.

Hide rarely used HTML tags: This removes all rarely used HTML tags from the pull down menu
to provide an easier (uncluttered) interface. Many of these rarely used HTML tags are not yet
supported by W3C but are in debate.

HTML TAGS

HTML color syntax highlighting: The user can specify the colors of the HTML tags in Web
Weaver's document editing windows (Web Weaver for Windows 95/NT) only. Different colors
can be set for HTML Table tags, regular tags and quoted items.

Use Uppercase HTML tags:By default, Web Weaver inserts uppercase HTML tags into the
document. Uncheck this checkbox to make Web Weaver insert lowercase HTML tags into the
document.

Use ending </P> tag when inserting <P>:By default, Web Weaver inserts an ending </P> tag
when you insert a paragraph tag <P>. Uncheck this checkbox to make Web Weaver only insert the
<P> start tag.

Use <DIV align=> tag instead of <P align=> tag:By default, Web Weaver uses the paragraph
tag <P> when inserting paragraph alignment tags. HTML 4 convention is to use the DIV tag
rather than the P tag for paragraph alignment. Checking this checkbox forces Web Weaver to
insert the DIV tag rather than the P tag for paragraph alignment. Careful: DIV is not understood
by older browsers.

Automatically insert carriage return when inserting <BR> tag: By default, Web Weaver inserts
the <BR> tag when you insert a line break. Check this checkbox if you want Web Weaver to
insert a carriage return after the <BR> tag each time you insert the <BR> tag.

Other View Menu items

VIEW PAGE WITH BROWSER 1 - Shortcut Key: F4
Pressing the Link to Browser button (or choosing its menu item) will result in the specified Web browser
displaying the active HTML document for previewing purposes. The browser path and filename MUST be
specified in the INI file located in the same directory as the Web Weaver executable file(for Windows 3.1x)
or in the Windows 95 Registry(for Windows 95). The following format should be followed in the INI file:

Browser=C:\netscape\netscape.exe
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The Windows 95 Registry contains this information in a similar format.

This information can easily be entered/edited by changing program preferences. Choose the View menu
item and then the Preferences menu item. A dialog box will display allowing you to change program
preferences and settings. You will see that you can specify 2 different browsers for viewing your Web
pages. The Browser#1 and Browser#2 text input boxes require the full path and filename of the Web
browsers you wish to use. For example, the Browser #1 entry may look like this:

c:\Program Files\Microsoft Internet\iexplore.exe

The easiest way to fill in this input box with the correct path and filename is to click the 'Browse' button
and search for the executable files on your hard drive. For Internet Explorer it is iexplore.exe and for
Netscape Navigator it is netscape.exe.
When you have found the appropriate file, select it and click OK. The correct path and filename will be
entered into the Browser text input box in the preferences section.

VIEW PAGE WITH BROWSER 2 - Shortcut Key: F5
Same as View Page with Browser 1.

FILE PROPERTIES
This displays information about the current HTML document.

FILE LIST
This toggles the display of the File List on the main Web Weaver window.

HTML Extensions

Listed below are the HTML tags found in the HTML Extensions pull-down menu.

BASEFONT - (Sometimes used)
The standard font size for the entire Web page can be set by using this tag at the beginning of your HTML
document. The range of sizes is from 1 to 7, where 2 is the default size.

CENTER - Shortcut Key: CTRL-E - (Sometimes used)
The text (or image) surrounded by this tag is centered in the browser window. Note that <P
Align=Center></P> and <DIV Align=Center></DIV> are more accepted versions of this tag.

Tag: <CENTER> text </CENTER>

LINE BREAK - Shortcut Key: CTRL-K - (Frequently used)
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The CLEAR attribute has been added to the Line Break tag to provide a way to jump to the next point in
the document where the following text or image can be flush next to the margin.

Tag: <BR CLEAR=right|left|all>

For example, CLEAR=left will break the line and move vertically down until you have a clear left margin.
CLEAR=right is similar, and CLEAR=all moves down until both margins are clear of images.

NO BREAK - (Sometimes used)
All text between the start and end of the NOBR elements cannot have line breaks inserted between them.

Tag: <NOBR> unbroken text </NOBR>

WORD BREAK - (Sometimes used)
This is used when you know exactly where you want a NO BREAK section to break. It also lets the
browser know where a line break is allowed to be inserted if necessary. There is only an opening Word
Break tag (no closing tag needed).

Tag: <WBR>

Tools Menu

The Tools menu contains commands for previewing your HTML document with browsers, stripping your
document of its HTML tags, opening programs associated with Web Weaver, and for accessing the
Spellchecker and the Site management tool.

REFRESH TAG COLORS - Shortcut Key: F2
This results in the refreshing of the HTML tag colors in the current document.

HTML STRIPPER - Shortcut Key: F6
This item will parse the current HTML document, remove all HTML tags, and save the remaining text in a
file of your choice. A dialog box will pop-up asking you to specify a filename for the stripped file.
References to images will be replaced with "[IMAGE]", <P> will be replaced with a carriage return, <HR>
will be replaced with a dashed line, and some special characters (quotation marks, for example) tags will be
replaced with the actual character.

OPEN GRAPHICS APPLICATION - Shortcut Key: F7
This item will open a graphics application of your choice for manipulating images. You can choose to
assign an image editing program or an image mapping program to this function.

OPEN FTP CLIENT - Shortcut Key: F8
This item will open the FTP Client program of your choice (assuming you've specified the correct path and
filename in your INI file using the Options/Preferences dialog box).

REPEAT LAST COMMAND - Shortcut Key: F9
This item will repeat the last HTML code that you entered into the current document. For example, if you
just entered the <FONT> tag with numerous settings and want to quickly insert that font tag for other text
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instead of selecting the text and selecting the same font values again and again, then you would use the
Repeat Last Command function.

CHECK LINKS (Web Weaver for Win 95/98/NT only)
This item allows the user to verify the local (on the user's hard drive) hyperlinks in the current document. It
will generate a report telling the user if images or linked Web pages are missing. Remote pages and images
(on the Web) cannot be checked at this time.

SPELL CHECK (available only in Web Weaver Gold)
You can spell check you HTML documents using this function. All HTML tags are part of the dictionary
included with Web Weaver so they will be skipped when the spell check is running. You can also add your
own words to the custom dictionary.

SITE MONGREL SITE MANAGEMENT (Web Weaver for Win 95/98/NT only)
This is a plug-in for Web Weaver that is a full Web site management tool. It allows the user to check all
the local links and images in a Web site with the click of a button. The Web site is checked on the user's
hard drive not on the remote Web server.

WEB PAGE STATISTICS (available only in Web Weaver Gold)
The Web page statistics tools allows you to view specific statistics about your Web page. Web Weaver
analyzes traffic to your Web page and generates a report containing graphs that display the statistics.

CONVERT TO HTML LIST/TABLE
This item will convert selected text into HTML List items or Table data. To convert existing text into List
items, the text must be separated by carriage returns. Click here for more information.

Window Menu

The Window menu contains commands for arranging and accessing the HTML document windows that are
currently open in Web Weaver.

Cascade
This lines the opened text windows in a cascading fashion.

Tile Horizontally
This tiles the opened text windows one on top of the other in a horizontal fashion for easier editing.

Tile Vertically
This tiles the opened text windows vertically next to each other (standing up) for easier editing.

Arrange Icons
This arranges any minimized text window icons on the bottom of the screen.

Move to Previous document - Ctrl-Tab
If you have more than one document open in Web Weaver, this will move between documents.
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Move to Next document - Shift-Ctrl-Tab
If you have more than one document open in Web Weaver, this will move between documents.

Close All
This will close all of the open documents in Web Weaver. If you have modified any document in any way,
Web Weaver will prompt you if you wish to save the changes.

Window List
This is a list of the currently opened documents. The currently highlighted document window is shown
checked on the window list.

Help Menu

The Help menu includes commands for accessing Web Weaver's online help file and tutorials.

Contents
Choosing the Contents menu item displays the Web Weaver help file which you are reading right now..

How to use Web Weaver
This tutorial gives you a quick guide to learning the basics of Web Weaver.

How to Upload your page to the Web
This tutorial informs users how to upload their Web pages to the Web.

Submit your Web page to Search engines
This menu item links to a Web page on McWeb Software’s Web site. The page has links to Search engines
so that you can easily submit your Web page to them.

Beginner Wizard
Beginner Wizard provides an easy way to learn the basics of HTML document authoring with an easy to
use, step by step process.

Tutorial
The Web Weaver tutorial provides a more in-depth look at how to write HTML documents. Discussion of
HTML tag formats and the basic elements of a Web page make it easy to learn HTML.

HTML Glossary
This glossary provides a list, definitions, and examples of HTML tags.

About
This is the well-known 'About' screen of every application. It displays some info on how to reach McWeb
Software.
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CHAPTER 3

Web Weaver Tools

This chapter discusses some of the different tools that Web Weaver has built into it. The
following tools are discussed below:

• Favorite URLs
• File Properties
• Check Links tool
• Global Find and Replace
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Favorite URLs

The following figure shows how your favorite URLs can be inserted into Web Weaver and retrieved easily
without having to type them in each time you insert hypertext or a linked inline image.

The Favorite URLs settings box allows you to input your favorite Web addresses (URLs) to allow easier
insertion instead of typing them in each time. You can specify 5 user-defined URLs and the other 15 URLs
in the list are the most recently used URLs. The hypertext and inline image dialog boxes use the Favorite
URLs pull-down boxes for easy input.

File Properties

The File Properties dialog box (shown below) displays information about the current HTML document in
Web Weaver.
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It displays the following information about a file:

File Type: Describes whether the file is an HTML document or an image file.
File Name: Lists the path and filename of the file.
Web Page Title: If the file is an HTML document, then the Title is listed.
Last Modified : The date and time the files was last modified.
File Size: The size of the file in bytes.

File Size including all images contained within it: The size of the file (in bytes) including files that are
referenced in the HTML document.

Time to download page using 14.4 modem- This indicates the amount of time (in minutes and seconds) it
takes to download the Web page using a 14.4 Kbps connection. This estimate includes the images that are
included in the Web page.

Time to download page using 28.8 modem- This indicates the amount of time (in minutes and seconds) it
takes to download the Web page using a 28.8 Kbps connection.

Check Links Tool

The Check Links tool is for verifying local hyperlinks and image links. This tool will not check remote
links on the Web such as http://www... links. It will only check the links on your local hard drive. This is
beneficial when you create your Web site on your hard drive and then upload it to a Web server. First
checking it on your hard drive and verifying all your links means that the links will be correct when you
upload it to a Web server. A screen shot of the Check Links dialog box is shown below:
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The different images next to the listed links have specific meanings. They are defined below:

- Valid hyperlink.
- Invalid hyperlink.
- Unverified remote link. This occurs when the link is remote such as http://www.yahoo.com.
- Valid image.
- Invalid Image
- Valid CGI script (note: this does not check the actual CGI script, only it's existence)
- Invalid CGI script

Other information about the document is listed at the bottom of the Check Links dialog box. This includes:

File Name
File Title
File Size(in bytes)
File Date - Date and time when file was last modified.
Time to download page using 14.4 modem- This indicates the amount of time (in minutes and seconds) it
takes to download the Web page using a 14.4 Kbps connection. This estimate includes the images that are
included in the Web page.
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Time to download page using 28.8 modem- This indicates the amount of time (in minutes and seconds) it
takes to download the Web page using a 28.8 Kbps connection.

Global Find and Replace

Global Find and Replace is the perfect tool for finding and/or replacing text in multiple HTML documents.
If you have a large number of Web pages in your Web site that need to have the same string of text
replaced in all of them, then this is the tool to use.

The Global Find and Replace dialog box is shown below:

To Find text in multiple documents (windows 95 version only):
- Type the text you wish to find into the first input box labeled 'Find this text' and select the files to search
from the file list box on the right-hand side of the Global Find and Replace dialog box (to select more than
one file, use the Shift or CTRL key while picking the files with your mouse).

- Click the Find button and Web Weaver will search the selected files for the text.
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- To view the number of found instances in each file, click on the 'Results' tab. The following screen will
be displayed, showing you the number of instances found in each document.

Double-click a file listed in the Results section to open it and Web Weaver will highlight all instances of
the ‘Find’ text.

To Find and Replace Text in multiple documents:
- Type the text you wish to find into the first input box labeled 'Find this text'.

- Type the replacement text into the second input box labeled 'Replace with this text'.

- Select the files to search/replace from the file list box on the right-hand side of the dialog box (to select
more than one file, use the Shift or CTRL key while picking the files with your mouse).

- Click the Replace button and Web Weaver will replace the text in the selected files. A report of the
number of replacements is generated in the form of a text file named 'Global Replace Results.txt' and it can
be found in the folder(directory) where the replacements were made. You can also view the results of
replaced instances by clicking on the 'Results' tab.

Double-click a file listed in the Results section to open it.

Suggestion:
You can narrow your searches by selecting the 'Match Case' checkbox. This will cause Web Weaver to
find only the exact match of the 'Find' text (case-sensitive).
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CHAPTER 4

What is HTML?

This chapter will teach you about HTML, the language that Web pages are written in.
The following steps will be taken to help you understand HTML.

• What is HTML?
• The basic elements of a Web page (HTML document)
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What is HTML?

The World Wide Web and Web Pages
The World Wide Web (WWW or "the Web") has taken off at a frantic pace. People are using it to convey
information about anything to anyone who may be interested in it. Products, services, interests, and every
other kind of information can be found on the Web. The great thing about the Web is that people can
access this information from all over the world.

The Web is made up of millions of "Web sites" and billions of "Web pages". Web sites are the collections
of Web pages, and the pages are what we see and read when we "surf" the Web. For example, the
Microsoft Web site contains thousands of Web pages which give information regarding Microsoft's
products and services. Web pages are fun to make, andWeb Weavermakes it a lot easier to create them!

Web Software
The software application that we use to view/read/interact with Web pages is called a browser. Two
examples of browsers are Netscape'sNavigatorand Microsoft'sInternet Explorer.

The software application that we use to create/write Web pages is called an HTML editor or a Web
authoring tool.Web Weaveris an example of an HTML editor. It has many built-in functions which
automate the creation of Web pages.

HTML: The Web Programming Language
Web browsers read Web pages and convert the code inside the page so that we humans only see a nicely
formatted page in the browser's window. What we don't see is the HTML code and document text that
makes up the Web page. What is HTML, you ask? Well, it's a text formatting language which defines
different text styles and page layouts for Web pages. Because it is text-based it doesn't take long to
download these files (Web pages) over a slow Internet.

What is an HTML tag?
An HTML tag is the "code" which controls the formatting of the Web page (text styles and page layout). It
is invisible when viewed in a Web browser. It only modifies the text and tells the browser what the text and
page should look like.
HTML tags consist of less-than and greater-than signs ( < and >) surrounding the main HTML tag text, for
example, <HTML TAG>. The tag can be uppercase, lowercase or both. It is not case sensitive, however
Web Weaver puts all code in capital letters to make it easier to see when editing HTML documents.

Many tags have opening tags and closing tags so that the Web browser understands where to begin and
where to end a certain property, such as font, text type, font size, color. For example, the HTML tag
which makes text appear bold to the user is simply the letter B enclosed in the HTML brackets, < >. If the
author of the HTML document puts the opening bold tag and doesn’t put a closing bold tag, how would the
browser know when to stop making the text bold? For example, if you wanted to make the word 'bird'
appear bold on the browser's screen you would type the code:

<B> bird </B>
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Note that the closing tag has a slash inside the brackets, and before the HTML code, B. This slash denotes
an closing tag, and tells the browser that any text after the bold closing tag </B> will NOT be bolded. So
if we were to include the word 'bird' in a sentence and only wanted 'bird' to be bolded, then we would type
this:

One of my favorite animals is the <B>bird</B> because it can fly .

This is how it will appear:

One of my favorite animals is the bird because it can fly.

If you wanted the entire sentence to be bolded, then the HTML bold tags would surround the entire
sentence as shown below:

<B>One of my favorite animals is the bird because it can fly.</B>

Your Web browser would display the sentence like this:
One of my favorite animals is the bird because it can fly.

Note that not all HTML tags have closing tags.

The Basic Elements of a Web Page (HTML Document)

Beginning an HTML document is not a difficult thing. Once you get the hang of it, you'll be writing Web
pages in no time. It is important to have good form when you are writing Web pages for several reasons.
One is so you can understand what you wrote in your document when you try to edit it at a later time.
Another reason to have good form is to ensure that the Web browser will understand what you wrote and
display the Web page as you intended.

Let's begin at the beginning. Some HTML tags are not required for your Web page to work properly, but it
is good practice to include them in your document. Web Weaver starts new documents with these tags so
you don't have to worry about putting them in.

1. The first and foremost tags are the <HTML></HTML> tags. This opening and closing tag pair
surround the entire HTML document, and they tell the Web browser that “this document is an HTML
document”. This tells the browser that it is to be displayed as a Web page. All other text and tags in
your Web page are enclosed by the <HTML></HTML> tags. Anything outside of the
<HTML></HTML> tags is usually ignored by the browser.

2. Next are the <HEAD></HEAD> tags. These enclose the head of the HTML document. The head of
the document contains information about the HTML document, but that information is never displayed
in the Web browser. This information is used by the browser to index or keep track of the document.
One of the main HTML tags that goes inside the <HEAD></HEAD> tag is the <TITLE></TITLE>
tag pair. This tells the browser the title of the Web page so it can refer to the page as 'something'. The
title is displayed on the browser's titlebar. The title is important because it is used by search engines to
refer to your Web page.
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3. The next important tag which follows the <HEAD></HEAD> tags is the <BODY></BODY> tag pair.
These tags enclose the body of the document (all the text and other HTML tags). The bulk of your
HTML code and text is located between the <BODY></BODY> tags. Whatever is contained within
the <BODY></BODY> tags will be displayed by the browse. Any text or tags outside of the body
tags are not meant to be displayed by the browser, and may be ignored by the browser (unless the
browser gets information from this text).

Here is the order in which these main HTML tags should be placed:

<HTML>

<HEAD>
<TITLE> This is the Title of the Web Page </TITLE>
</HEAD>

<BODY>

All the text of the document should be typed here.

</BODY>
</HTML>

See Web Weaver's Beginner Wizard for additional explanation of these tags.
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CHAPTER 5

Creating your first Web page

This chapter will teach you the basics of using Web Weaver to create your first Web
page. The following steps will be taken to guide you and get you accustomed to using
Web Weaver.

• setting Web page properties
• typing text into Web Weaver
• formatting text with different font styles and sizes
• creating a hyperlink to another Web page
• inserting an image into the Web page
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Setting Page Properties

The first step in creating your Web page is to set its page properties. This includes:
• setting the title of the Web page
• setting the background and text colors
• inserting the background image (if any)

To set these properties, choose the ‘Page Properties’ menu item from the ‘Insert’ menu (or click the Page

Properties button on the Button Bar ). The following dialog box will appear:

1. First, we should set the title of your page. This is an important part of your Web page because it acts
as the Web page's main title. In the box labeled 'Enter the Title of your Web page:', type the title you
wish your Web page to have.

2. Now we want to set the background color of your Web page to make it exciting. Click on the ‘Colors’
tab in the Page Properties dialog box.



Page 33

33

3. Next to the text label "Background Color:" there are two boxes. Click the gray box on the right and a
'Select Color' dialog box will appear. With your mouse select one of the preset colors or create your
own custom user-defined colors. After you have selected a color in the 'Select Color' dialog box click
the OK button and the hexadecimal code for that color will be input into the Background color text
box. Also, the background of the Preview window will change to the color that you have selected to
give you an idea of what the color will look like.

4. When selecting other colors for your page (such as text color, link color, etc.) in the Page Properties
dialog box, the colors will be displayed in the Preview window so that you can see if the colors work
well together. Some colors such as dark red text and a dark blue background won't work well together
because a user can't easily read the page. There isn't enough contrast between these two colors.

The HTML code which is inserted will look like this:

<BODY BGCOLOR=" #FFFFFF">

Background Images

If you would rather have a background image instead of a background color then follow these instructions.

1. Click the ‘Background Image’ tab and the following screen will appear:

Here’s a tip: Background images are usually small images that repeat (or tile) all over the
background of your Web page, so it might not look right if you use just any image for
your background. Background images are usually seamless, meaning that you can’t see
where the image repeats itself. This creates a background that looks like one large image
or pattern. Choose your background images wisely!



Page 34

34

In the box labeled "Enter graphic filename for background:", type the filename of the image you wish to be
your Web page background image (or browse for the image using the browse button). For our example,
this is the filename "seabkg.gif."

(Instead of typing the name of your image into this box you can also ‘browse’ for it by clicking on the
button next to the textbox. This will open another dialog box which allows you to search for your
image. When you find the image, click OK and the image filename will appear in the textbox.)

The HTML code that is inserted in your document is:

<BODY BACKGROUND=”pattern.gif”>

Caution: It’s easier to put your images in the same directory (folder) as your HTML files. If your
images reside in a directory (folder) that is different from the HTML document directory, then you
need to specify the directory name when inserting an image into your HTML document. Otherwise
the browser may not be able to find the image when it opens the HTML document.

For example, if your HTML document and images both reside in the directory c:/work then you do not
need to specify a directory name. You would specify “pumpkin.gif” as your image name.

If your HTML document resides in the directory c:\work and your images reside in c:\work\images then
you would need to specify “images/pumpkin.gif” as your image name.
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Typing Text Into Web Weaver

Typing text in Web Weaver is easy! In Web Weaver’s Document window, place the mouse cursor in the
location where you want to begin typing. You can either click in the Document window using your mouse
or move the cursor using the arrow keys on your keyboard. Now start typing! Remember, most text
should be typed between the opening and closing <BODY> tags in an HTML document. As shown below:

<BODY>

Type your text in between the <BODY> tags. This is an important
rule in HTML.

</BODY>

While you type your text into the HTML document you can add some HTML formatting tags to define
your text styles and sizes. The most common styles are bold, italic, and underline. These styles enhance
the physical appearance of the text. To make a word appear in boldface you can perform this procedure in
two manners:

1. Type the word into the text window first, then apply the style to it, or
2. Insert the style and then type the word.

Let's try the first one. Type the word "bird" into the text window. Now select the word with the cursor by
holding the SHIFT key down and using the arrow keys to highlight the word. Now apply the bold tag to
the highlighted text by either

- clicking the bold (B) button in the toolbar,
- selecting the bold menu item (under the Insert | Physical Styles menu), or
- using the shortcut keys Ctrl-B (hold down the Ctrl key and push the letter B).

Be sure to learn all the shortcut keys (found in the Help file) because they will save you a lot of time!

Now let's try the second method. Insert the bold tag into the text window by either

- clicking the bold (B) button in the toolbar,
- selecting the bold menu item (under the Insert | Physical Styles menu), or
- using the shortcut keys Ctrl-B (hold down the Ctrl key and push the letter B).

You will notice that the HTML tags are inserted and the text cursor is automatically positioned between the
tags so you can conveniently start typing text that you want to be formatted with the bold tag. Now type
the word "bird".

Use the heading tags to change the size of the text in your Web page (HTML document). These HTML
tags range from sizes 1 through 6 (1 being the largest). The tag appears like this:

<H1> bird </H1>

Using the instructions above, format different text to have different heading sizes.
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Creating a Link (How to Insert Hypertext)

What is hypertext? Hypertext is text that links to another Web page or file. When a user clicks on the
hypertext with their mouse pointer, the browser loads the Web page that the hypertext is linked to.
Hypertext is often a different color than normal text and it is also underlined.

Inserting hypertext in Web Weaver is easy. This process can be started one of two ways:

- Select existing text that you wish to make into hypertext, or

- Place the cursor in the location where you want to insert new hypertext.

Let's try starting from scratch! Our example is going to have the word "dog" be hypertext which is linked
to another Web page named "canine.html." When a user viewing your Web page clicks on the hypertext
"dog", the new Web page canine.html will be displayed in the browser. Let’s get started!

1. Place your cursor in the location where you want to insert the hypertext.

2. Now select the 'Insert' pull-down menu and choose the 'HyperLink' menu item (or click on the hypertext

toolbar button ). This will open the 'Insert HyperLink' dialog box shown below.

3. In the box labeled "Enter Hyperlink text:", type the text you wish to be hypertext in your Web page
(HTML document). For our example, this would be the phrase "Click here to go to my page"

4. In the box labeled "Enter URL of Web page or file to link to:" type the name (URL) of the Web page to
link to (http://www.mcwebsoftware.com/mypage.html, in our example). The Advanced attributes can be
left blank.

5. Click the OK button and the HTML code for a hyperlink is inserted into your Web page.
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(You could also start this process by selecting existing text in you HTML document and then follow steps 2
through 5 to insert the hypertext.)

The HTML code should look something like this:

<A HREF=" http://www.mcwebsoftware.com/mypage.html"> Click here to go to my page</A>
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Inserting an Image into your Web page

Inserting an image in Web Weaver is VERY simple. Our example is going to involve inserting an image
file named pumpkin.gif into your Web document. Let's try it!

1. First save your Web page. Give it a filename and save it onto your computer’s hard drive. Place your
cursor in the location where you want to insert the image.

2. Now select the 'Insert' pull-down menu and choose the 'Image' menu item (or click on the Insert Image

toolbar button ). This will open the 'Insert Image' dialog box shown below.

3. In the box labeled "Enter filename of image:", type the filename of the image you wish to insert into your
Web page. For our example, this would be the filename "at_work.gif." This is the only required input field
in this dialog box. The others fields are all optional attributes, so we won't discuss these at this moment.

Instead of typing the name of your image into this box you can also 'browse' for it by clicking on the button
next to the input box. This will open another dialog box which allows you to search for your image. When
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you find the image, click OK and the image filename will be inserted into the input box. You can also
browse the image file list on the lower half of the Image dialog box to select an image.

Caution: The browser might not be able to find the image when it opens the Web page if you inserted an
image before saving the Web page for the first time. If you didn’t save your Web page before inserting an
image your image may have to reside in the same directory/folder as the Web page. If your image does not
reside in the same directory/folder as your HTML document, then you can specify the image directory by
typing it into the second input textbox on the 'Insert Image' dialog box or by clicking the 'Fixed directory'
checkbox next to the filename input textbox.

4. If you wish to link the image to another Web page (i.e., make a hyperlink), click the "Link to URL” tab
at the top of the Insert Image dialog box. In the box type the name (URL) of the Web page to link to
(construction.html, in this example).

5. Finally, click the OK button and the HTML code for an inline image is inserted into your Web
document. When viewing your Web page in a Web browser, the image will be displayed. If a user clicks
on the linked image, their browser will load construction.html.

The HTML code should look something like this in your document:

<IMG SRC="at_work.gif">

or if it's hyperlinked:

<A HREF="construction.html"> <IMG SRC="at_work.gif"></A>
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CHAPTER 6

Intermediate Web page design

This chapter will teach you intermediate lessons of Web Weaver. The following topics
will be discussed to teach you how to format your text, paragraphs and images to obtain
pleasing Web page layouts.

• formatting text
• formatting paragraphs
• horizontal lines
• using special characters
• creating lists
• more about setting Page Properties and advanced properties
• setting advanced image properties
• inserting anchors
• more about creating hyperlinks
• creating an email link
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Formatting Web Page Text

Usually, the main element of a Web page is the text. The text allows users to gain information about
whatever the Web page discusses. We all know that typing text is easy, but formatting it and laying it out
is the difficult task. Well, you could just have all of your text be the same size, same font, same look, same
feel, same boring words typed over and over OR you could use some of the HTML physical style and
paragraph tags to really spice things up. A Web page with a boring layout will attract no one, but a nicely
formatted page will keep them coming back for more.
First, we will talk about text size. The HTML 2.0 specification calls out different heading sizes which are
used to change on-screen text size. These headings have basic opening and closing tags in the form
<H1></H1> to <H6></H6> (H1 being the largest font size). For example, if you wanted the on-screen
title of your page to be 'Dogs and Cats: Can They Be Friends?', you may want to have this text be larger
than the normal text so it stands out as the title of the page. To do this type:

<H1>Dogs and Cats: Can They Be Friends?</H1>

This will appear like:

Dogs and Cats: Can They Be Friends?

These headings are useful, but unfortunately they can only be used on one line at a time. In other words, if
I wanted 'Dogs' to be one size and 'Cats' to be another, I couldn't use HTML 2.0 heading tags. As soon as I
specified a heading for a word/phrase, the next word following the heading closing tag </H1> would be
placed on the next line. Any text size change would result in one text size per line.

The HTML tag <FONT SIZE=#></FONT>, where # is a number from 1 to 7 (1 being small size, 7 being
large), can be used to change the text size of each letter in a word, if desired. It is much more versatile
because it allows you to have more than one font style on the same line of text. For example, if you wanted
the word 'bird' to have a large 'b' and a somewhat smaller 'd', you could type:

<FONT SIZE=7>b</FONT>ir<FONT SIZE=5>d</FONT>

would appear like:

bird

You may wish the appearance of the text to be different, also. There are bold and italic tags so you can
highlight or appropriately format your text as you need to. These tags are simple tags and follow the same
format as the tags discussed above. They have opening and closing tags that surround text that they
enhance. For example, to make a word bold, simply follow this syntax:

<B>word</B>
and it will appear like:word

To include it in a sentence, follow this example:

This <B>word</B> will appear bold in this sentence.

and you will see:
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This word will appear bold in this sentence.

Some common styles are:bold, italic, and underline. Let’s look at an example of how to format some text
in Web Weaver.

To make a word appear in boldface you can perform this procedure in two ways:

• Type the word into the Document window first, then apply the bold style to it, or
• Insert the bold style HTML tags and then type the word.

Let’s try the first one. Type the word “bird” into the Document window. Now highlight the word with the
cursor by holding the SHIFT key down and using the arrow keys to highlight the word (or use the mouse to
highlight the word). Now apply the bold style to the highlighted text by either

• clicking the bold (B) button in the Button Bar,
• selecting the bold menu item (under the Insert | Physical Styles menu), or
• using the shortcut keys Ctrl-B (hold down the Ctrl key and push the letter B).

You may want to learn all the shortcut keys (found in the Help file) because they will save you a lot of
time!

Now let’s try the second method. Insert the bold tag (<B></B>) into the text window by either

• clicking the bold (B) button in the Button Bar,
• selecting the bold menu item (under the Insert | Physical Styles menu), or
• using the shortcut keys Ctrl-B (hold down the Ctrl key and push the letter B).

You will notice that the HTML tags are inserted and the cursor is automatically positioned between the
tags so you can conveniently start typing text that you want to be formatted with the bold tag. Now type
the word “bird”.

Other styles can also be used to change the appearance of your Web page text. These are found under the
Insert menu item in the Physical Styles or Logical Styles sub-items.

Using the Format Character dialog box
We can also change the formatting of text by using the Format Text dialog box (shown below). This dialog
box gives you the ability to change many font properties of the text you have selected. The font, color,
physical styles, logical styles, position and font size can be specified.
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Tag:
<FONT FACE="Arial " SIZE= 2 COLOR=Red>text </FONT>

Using the Font Face ‘more’ button, the author can insert multiple font names into the input box. The Font
tag will accept multiple font names in case the browser being used does not support the first font name
found, it will use the second, and so on. The author can also insert a Font name manually by typing in the
Font name input box.
The Font color can be specified by typing in the color name (red, blue, etc.) or by using the color selection
box to specify a color other than a primary color. This latter option will insert the RGB code for the color.

Try this example:

1. Select some text in the Web Weaver Document window.
2. From the Menu Bar select the Text item from the Format menu (or click the (A) button on the Button

Bar). The Format Text dialog box will appear (as shown above). This dialog box allows you to
choose different font styles, sizes, colors and other properties that will affect the appearance of the text
you have selected.

3. Select a Font Face from the pulldown menu on the Format Text dialog box (for example, MS Sans
Serif).

4. Select a Font Size (try size 5).
5. Select a Font Color by clicking on the gray box next to the Font Color text box. The Color picker

dialog box will appear and you can select a color of your choice.
6. Now click the Bold item in the Format Text dialog box.
7. Now click the OK button to finish.
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Now save the document in Web Weaver and preview it using your Web browser (or by clicking on the
(EYEGLASSES) button. Do you see how your text has changed to your settings?

Formatting Paragraphs

There are several paragraph elements that can add to your Web page for a cleaner format. One of the main
elements is the horizontal rule. This is simply a line which spans from the left side of the screen to the
right. It serves the purpose of separating one thing from another on the page. It looks great under the title
of your Web page by separating the main text from the big lettered heading, as shown below:

Dogs and Cats
----------------------------------------------------------------------------------------------------------

Dogs and cats don't always get along, but there are examples of them being very friendly to each
other, and often being best friends.

The tag for a horizontal rule is simply <HR> (with no closing tag). It isn't associated with any text. In
other words, it stands alone.

Another important paragraph tag is in fact the Paragraph tag <P></P>. The current HTML 2.0
specification requires only the opening tag <P>, but HTML 3.0 will include both opening and closing tags
because alignment attributes will be included with this tag. These will allow you to align/justify specified
paragraphs to the right, center or left. The paragraph tags <P></P> define the beginning and end of a
paragraph. When the browser sees the <P> tag it starts the following text on a new line. The following
code shows this:

This is the last sentence in paragraph 1.<P>This is the first
sentence in paragraph 2.</P>

will look like this:

This is the last sentence in paragraph 1.

This is the first sentence in paragraph 2.

Another important paragraph element is the Line Break <BR>. The line break has only the opening tag
and it isn't associated with any text much like the horizontal rule tag <HR>. The line break will break a
line of text wherever the <BR> tag was positioned. The text following the <BR> tag will be forced onto
the next line. For example:

I want this sentence to be broken in the<BR>middle so it won't go all
the way to the right margin.

Displayed as:
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I want this sentence to be broken in the
middle so it won't go all the way to the right margin.

Horizontal Lines

As mentioned above, horizontal lines are used to separate sections of a Web page. The user can specify the
thickness, width, alignment, and shading of the line.

Line Thickness:
Allows the user to set the thickness of the horizontal rule in pixels.

Tag: SIZE=number

Length of Line (across screen):
The default horizontal rule is always as wide as the page. The user can specify the desired width in pixels
or percent of document width.

Tag: WIDTH= number of pixels|percent

Align:
Horizontal rules that are not the width of the page can be aligned next to the left margin, right margin, or
centered on the page.

Tag: ALIGN=left|right|center

NoShade:
Noshade allows the user to specify a solid bar rather than the shaded default.

Tag: NOSHADE
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Special Characters

These characters are characters that must be represented by specific tags because they are interpreted as
HTML tags themselves or they are not represented by a key on the standard keyboard. Below are the
different categories of special characters that you can easily select from their respective dialog boxes.

• Vowels
• Various
• Math Variables

Vowels (Special Characters)
The Vowels special characters dialog box helps you to insert vowels from different languages into your
Web document very easily without knowing the special character codes.

When you choose the Vowels special characters menu item, this dialog box appears:

You can do one of two things:
1. To insert ONE vowel click on the appropriate vowel. The HTML code will be inserted into the

document and the Vowels dialog box will close, or

2. If you have more than one vowel to insert, click on the check box in the lower left hand corner of the
dialog box and then click on all the vowels you wish to insert. Then click close to close the dialog box.
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Various (Special Characters)

Math Variables (Special Characters)



Page 48

48

Creating a Bulleted List (Unordered List)

Uses:To create a bulleted list as shown below.

• Cookies
• Cake
• Pie

______________________________________________________________________________

When this button or menu item is selected, the following dialog box appears:

This box allows you to insert bulleted list items into your HTML document. Using this dialog box makes it
easier to code since you don’t need to know the actual HTML tags. You can just type each bulleted item
and this program inserts the correct HTML tags into the document.

In the box marked: “Enter text for each bulleted list item” type an item you wish to be bulleted in your list.
If you are entering the first bulleted item of your list, type it in the box, and then click on the “Insert 1st
List Item” button. Otherwise just type in each bulleted list item and click on the “Add a List Item” button.
When you are entering the last list item type it in the text box and click on the “Add Last List Item” button.
These operations will insert the correct tags in the HTML document.

If you have previously made a bulleted list in your HTML document and wish to add a bulleted list item
into that list, then place your cursor in the position where you wish this list item to go, select the Bulleted
List Menu Item, type the list item into the text box, hit the “Add a List Item” button and then click the
“Done/Cancel” button.

You can also choose an alternative to round bullets in your bulleted lists. Circle, disc, or square bullets can
be chosen. Clicking on the desired bullet typebefore clicking "Add First List Item" will change the bullet
type in the entire list.

When using a browser to view your HTML document a coded bulleted list like the following:
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Tags:
<UL>
<LI>Cookies
<LI>Cake
<LI>Pie
</UL>

will appear like:

Cookies
Cake
Pie

Note: If text has been selected in the main text area of Web Weaver and the Bulleted List dialog box is
opened, then that selected text will appear in the Bulleted List text box.
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Creating a Numbered List (Ordered List)

Uses:To create a numbered list as shown below.

1. Cookies
2. Cake
3. Pie
______________________________________________________________________________

When this button or menu item is selected, the following dialog box appears:

This box allows you to insert numbered list items into your HTML document. Using this dialog box makes
it easier to code since you don’t need to know the actual HTML tags. You can just type each numbered
item and this program inserts the correct HTML tags into the document.

In the box marked: “Enter text for each numbered list item” type an item you wish to be numbered in your
list. If you are entering the first numbered item of your list, type it in the box, and then click on the “Insert
1st List Item” button. Otherwise just type in each numbered list item and click on the “Add a List Item”
button. When you are entering the last list item type it in the text box and click on the “Add Last List
Item” button. These operations will insert the correct tags in the HTML document.

If you have previously made a numbered list in your HTML document and wish to add a numbered list
item into that list, then place your cursor in the position where you wish this list item to go, select the
Numbered List Menu Item, type the list item into the text box, hit the “Add a List Item” button and then
click the “Done/Cancel” button.
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You can also choose an alternative to numbers in your numbered lists. Uppercase and lowercase letters
and Roman numerals can be chosen. Clicking on the desired number typebefore clicking "Add First List
Item" will change the number appearance in the entire list.

When using a browser to view your HTML document a coded numbered list like the following:

Tags:
<OL>
<LI>Cookies
<LI>Cake
<LI>Pie
</OL>

will appear like:

1. Cookies
2. Cake
3. Pie

Numbered lists can also look like:

I. Cookies
II. Cake
III. Pie

i. Cookies
ii. Cake
iii. Pie

A. Cookies
B. Cake
C. Pie

a. Cookies
b. Cake
c. Pie

Note: If text has been selected in the main text area of Web Weaver and the Numbered List dialog box is
opened, then that selected text will appear in the Numbered List text box.



Page 52

52

Creating a Descriptive List

Uses:To create descriptive lists which contain a list topic and then list text below it.

Cookies-my favorite dessert
These are my favorite snack in the whole world wide web.

Cake-my second favorite dessert
Cake is my second favorite. It tastes good with ice cream.

Pie-my third favorite dessert
I like pie, too, but it doesn’t compare to the first two desserts!

_____________________________________________________________________________

When this button or menu item is selected, the following dialog box appears:

This box allows you to insert descriptive list items into your HTML document. Using this dialog box
makes it easier to code since you don’t need to know the actual HTML tags. You can just type the of each
descriptive item and this program inserts the correct HTML tags into the document.

In the box marked: “Descriptive List Topic:” type a list topic you wish to be in your descriptive list and in
the box marked: “List Text to follow List Topic:” type in the text that will follow below the list topic. If
you are entering the first descriptive topic and text items of your list, type them in their respective boxes,
and then click on the “Insert 1st Topic and Text” button. Otherwise just type in each descriptive list topic
and text item and click on the “Add Topic and Text” button. When you are entering the last list topic and



Page 53

53

text items type them in their respective text boxes and click on the “Add Last Topic and Text” button.
These operations will insert the correct tags in the HTML document.

If you have previously made a descriptive list in your HTML document and wish to add a descriptive list
topic and text item into that list, then place your cursor in the position where you wish this list item to go,
select the Descriptive List Menu Item, type the list topic and text items into their text boxes, hit the “Add
Topic and Text” button and then click the “Done/Cancel” button.

When using a browser to view your HTML document a coded descriptive list like the following:

Tags:
<DL>
<DT>Cookies-my favorite dessert
<DD>These are my favorite snack in the whole world wide web.
<DT>Cake-my second favorite dessert
<DD>Cake is my second favorite. It tastes good with ice cream.
<DT>Pie-my third favorite dessert
<DD>I like pie, too, but it doesn’t compare to the first two
desserts!
</DL>

will appear like:

Cookies-my favorite dessert
These are my favorite snack in the whole world wide web.

Cake-my second favorite dessert
Cake is my second favorite. It tastes good with ice cream.

Pie-my third favorite dessert
I like pie, too, but it doesn’t compare to the first two desserts!
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More about setting Page Properties

Uses:
The colors and background image(wallpaper) of a Web page can be changed by specifying a color or an
image file to tile on the background. Also, colors of text, linked text, visited text, and active text can be set
by using this dialog box.

Tag:
<BODY BACKGROUND="filename " BGCOLOR=###### TEXT=######

LINK=###### ALINK=###### VLINK=######>

Attributes:
BACKGROUND specifies the background image
BGCOLOR specifies the background color in hexadecimal code
TEXT specifies the text color in hexadecimal code
LINK specifies the color of hyperlinked text in hexadecimal code
ALINK specifies the color of active hyperlinked text in hexadecimal code
VLINK specifies the color of visited hyperlinked text in hexadecimal code

When this button or menu item is selected, the following dialog box appears:

To Set Document Title:
The document title is used by the browser to identify the main title of the HTML document. Usually, the
HTML page title is displayed in the titlebar of the browser window.

To Set Web page colors:
Select the ‘Colors’ tab and the following input boxes will appear:
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If the you know the RGB color codes, then they can be entered into the text boxes using the keyboard.
Otherwise, you can click the Select color boxes and the color palette will appear. You can then choose
from a wide range of colors.

• BGCOLOR=###### is the screen background color.
• TEXT=###### is the color of the normal on-screen text.
• LINK=###### is the color of the hypertext (linked text) which hasn't been visited(clicked on) yet.

• ALINK=###### is the color of the hypertext when it is being clicked on(Active LINK).
• VLINK=###### is the color of the hypertext after it has been visited(clicked on).

or select the color scheme from another Web page by clicking the 'Another Web Page' button.

Setting the Background Image (wallpaper):
Select the ‘Background Image’ tab and the following input boxes will appear:
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You can browse for a background bitmap file or type the filename into the text input box. You can make
the background wallpaper image into a static watermark by clicking on the watermark check box. The
background image will then remain stationary in your Web page while text and images will scroll over the
image. The code BGPROPERTIES=FIXED will fix the background image as a watermark. This is an
Internet Explorer extension only.

Setting Margins:
Select the ‘Margins’ tab and the following input boxes will appear:

Left Margin (Internet Explorer only):
The user can set the Web page left margin to any width (default is zero). This attribute is specified in
pixels.

Top Margin (Internet Explorer only):
The user can set the Web page top margin to any height (default is zero). This attribute is specified in
pixels.

___________________________________________

Clicking on the OK button will insert the HTML code for your Page Properties. The location of your
cursor in the document is not important. Web Weaver will find the <BODY> tag and insert the Page
Properties in the appropriate locations.

Setting Advanced Properties of your Web page
There are particular advanced properties of your Web page that you can set using the Page Properties
dialog box. They are the following:

• Web page description
• Web page keywords
• Web page splash screen capabilities

When the META tag button is clicked, the following dialog box appears:
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META tags are defined within the <HEAD></HEAD> tags in your HTML document. They are as
follows:

Description allows you to provide a one paragraph description of the content of your Web page. Many
search engines use the first 250 words of your Web page as a description when they display a link to your
page. Well, the full description of your Web page may not be in the first 250 words of your document. By
specifying the META tag description in your document, search engines will use this description instead of
the first 250 words.

Keywords allow you to specify which words are important in your document or relevant words/phrases
which search engines will use to index your page. By entering keywords using this META tag search
engines will read the META tag and use those specified keywords. For example, if you have a Web page
about birds and you put META tag keywords such as "animals, birds, flying, eagle, hawk" then when you
are searching (using a search engine) for Web documents containing any of these words, your Web page
will be displayed (given that you have registered with the search engines).

Splash Screenallows you to specify that a Web page will refresh itself or load a different Web page after
a specified number of seconds. If you want your Web page to update itself every 30 seconds because you
have changing information (dynamic Web page) you can specify it using this advanced setting. If you want
a Web page on your site to be displayed for 10 seconds and then automatically display another Web page
without the user clicking anything, then you can specify it using this advanced setting.
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More about inserting images into your Web page

Uses:
To insert an image in your Web page. The image can also be made into a hyperlink to link to another Web
page or image.

Tag: <IMG SRC="inline image ">

Attributes:
WIDTH Sets the width of the image in pixels
HEIGHT Sets the height of the image in pixels
HSPACE Sets the space to the left and right of theimage in pixels
VSPACE Sets the space above and below theimage in pixels
BORDER Sets the border thickness around the image
ALT Sets the alternative text which is displayed in text-based browsers or before the image

is loaded
ALIGN Sets the alignment of the image to neighboring text

When this button or Image menu item is selected, the following dialog box appears:
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In the box marked: “Enter filename of Inline Image” enter the filename of the image You can use the
browse button to find the image on your hard disk. Also, you can use the image browser located on the
lower half of the dialog box. Browse through folders on your hard drive to view images to select the
desired image.

The following attributes are all optional:

ALTERNATIVES:
Select the ‘Alternatives’ tab and the following input boxes will appear:

Specifying alternative text for browsers that can't display images
In the box marked: “Enter ALTernative text to replace image in text browsers” type the text that you wish
to appear if people are not able to see the image in non-graphical Web browsers. For example, if you type
'[BIRD PHOTO]' in this text box, then the text '[BIRD PHOTO]' will appear in text-based Web browsers.
In current Web browsers, this ALT text is displayed when you move your mouse pointer over the image in
the browser window.

Specifying an alternative low resolution image for slow connections
In the box marked: “Alternative Low-res image” type the filename of (or browse for) the low resolution
image you wish to be loaded initially by the browser. Because the specified low-res image should be
smaller in size, it will download faster and provide an image until the browser has a chance to download the
actual image that will replace low-res image.
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LAYOUT:
Select the ‘Layout’ tab and the following input boxes will appear:

Specifying the image width and height
The images WIDTH and HEIGHT can be specified in pixels in the input boxes provided.

HTML Tag: <IMG SRC="dog.gif" WIDTH=value HEIGHT=value>

Specifying these values speeds up the display of your Web page while it is loading.
Web Weaver will automatically insert the height and width properties if you browse for your image using
the browse button or image browser.

Specifying spacing between text and images
To allow the user greater flexibility in laying out images and text use the Horizontal Space (HSPACE) and
Vertical Space (VSPACE) attributes. Specified in pixels (default value is zero).

HTML Tag: <IMG SRC="dog.gif" VSPACE=value HSPACE=value>

These attributes control the vertical space above/below and the horizontal space to the left and right of the
image. Specifying HSPACE=5 and VSPACE=5 will prevent neighboring text and images from coming
within 5 pixels of the image.

Specifying an image border
The width of the border around the image can be specified in pixels (default is zero for normal images and
1 for linked images).
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HTML Tag: <IMG BORDER=value>

This controls the thickness of the border around the displayed image. Setting BORDER=0 will show no
border. This may be confusing if the image is linked because the colored border that signifies a link will
not be displayed.

Aligning text and images
To align neighboring text and images with the current image in your Web page or to align the image on the
left/right side of the screen with neighboring text wrapping around it specify this in the align selection
boxes. The Align Preview box will show you how the text will appear next to the image depending on
which alignment you have chosen and what other images you have in the same line.

HTML Tag:
ALIGN=left|right|top|texttop|middle|absmiddle|baseline|bottom|absbottom

Alignment attributes are Left, Right, Baseline, AbsMiddle, AbsBottom, and TextTop.

Left/Right:
These alignments provide a floating image type. Aligning left will float down and over into the left margin,
and subsequent text will wrap around the right hand side of that image. Align=right aligns the image with
the right margin and text wraps around the left hand side of the image.

Top/Middle/Bottom:
Top aligns the image with the top of the tallest item in that line.
Middle aligns the image with the middle of the tallest item in that line.
Bottom aligns the image with the bottom of the tallest item in that line.

Absmiddle:
This aligns the middle of the current line with the middle of the largest item in the line.

Baseline:
This aligns the bottom of the image with the baseline of the text in the current line.

Absbottom:
This aligns the bottom of the image with the bottom of the lowest item in the current line.
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LINKING:
To link the image to another Web page select the ‘Link to URL’ tab and the following input boxes will
appear:

If you wish to link the image to a Web page (URL), another image or file, type the URL (address) or
filename in the appropriate input box. The pull-down box makes it easy to keep all of your favorite URLs
at your fingertips so you don't have to keep typing them. See the Favorite URLs page for information on
how to setup your favorite URLs. You can also use the browse button to look for the filenames to enter
into this input box or browse Internet Explorer Favorites using the button.

When using a Web browser to view your Web page the image will be displayed and will be outlined in blue
if it is linked, rendering it clickable (clicking on the image will link you to the specified page/file.)

ADVANCED
Select the ‘Advanced’ tab of the Image dialog box and the following input boxes will appear:

It allows you to insert videos into your Web page and to specify imagemap settings.
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Video
The attributes of a video clip are as follows:

The input box labeled ‘Enter filename of Video Clip’ requires the filename of the video clip. The author
can either type the video filename or search for the file using the browse button.

• The Loop attribute specifies how many times a video clip will loop when activated. If the number
specified is 1 or 'Infinite' then the video will loop indefinitely.

• The Start attribute specifies when the video clip should start playing.

- FILEOPEN means start playing as soon as the file is done opening.
- MOUSEOVER means start playing when the user moves the mouse cursor over the animation/video.
- Both FILEOPEN and MOUSEOVER can be specified as well.

• The VCR Controls checkbox determines if video playback controls will be displayed on the Web page.
The controls will be displayed on the Web page under the video clip if this checkbox is checked.
(Default is Hide Controls).

Imagemaps
If your image is going to be an imagemap, then you can specify whether it is a server side or client side
imagemap. If it is a client-side imagemap you must enter the name of the map. If it is a server side
imagemap see the server-side imagemap information. It can be both a server-side and client-side
imagemap.

When you are finished entering all the information into the dialog box, click OK to insert the HTML code
into your Web page.
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Inserting an Anchor (Bookmark)

Uses:
Used for establishing a destination anchor at a specific point in a Web page so that it may be linked to from
the same or a different document (Web page). This is useful for creating a long Web page with hyperlinks
at the top of the page which link to different anchors in the same Web page.

Tag:

<A NAME=" anchortext"> some text</A>

When this button or menu item is selected, the following dialog box appears:

This dialog box helps you to insert an anchor in your Web page. Think of it as placing a bookmark at a
specific point in the Web page. Different Web pages or hypertext can link to that specific bookmark
(anchor) and the Web page will be displayed at that particular bookmark (anchor) when it is loaded in a
browser. You will not see the anchor when viewing the Web page. It is like an invisible bookmark.

To create an anchor:
In the box labeled 'Anchor/Bookmark name', type the name of the anchor. When creating the hypertext that
will link to this anchor you will specify this anchor name to link to it. See the section on Creating a
Hyperlink to learn how to create a hyperlink to an anchor.

In the box labeled 'Enter the text that will be the Anchor/Bookmark’, type the text that will appear on the
page at the location of the bookmark This is optional. You can simply leave this blank and the anchor will
be placed in the location of your cursor in Web Weaver’s document window.

Example
Suppose you want to create an anchor that is located halfway down a Web page. When the user views the
page in a Web browser, they can click a link at the top of the page that will automatically bring them to
that anchor/bookmark halfway down the page.
The text that you want to anchor is “Chapter 2: The Human Skeleton” and you want the anchor name to be
“skeleton”.

- In the box labeled 'Anchor/Bookmark name', type “skeleton”.

- In the box labeled Enter the text that will be the Anchor/Bookmark, type “Chapter 2: The Human
Skeleton”.



Page 65

65

Then click the OK button.

You’ve created the anchor/bookmark, but you still need to create a link to that anchor. This can be done by
creating a Hyperlink (see the Creating a Hyperlink section).

Creating a hyperlink to an anchor
The HTML hyperlink tag that will link to an anchor is equivalent to a regular hyperlink tag except it has
the anchor name included (separated by a '#'' pound sign). For example, linking to an anchor named 'ch1'
from within the same Web page would look like:

<A HREF="#ch1">Click here for Chapter 1</A>

Linking to an anchor named 'ch1' from a different Web page named "toc.html" would look like:

<A HREF="toc.html#ch1">Click here for Chapter 1</A>
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More about creating hyperlinks

Uses:
To create text which is linked to another Web page(URL), image, sound file, etc.

Tag: <A HREF="link "> linked text </A>

When the HyperLink button or menu item is selected, the following dialog box appears:

This box allows you to insert hypertext into your Web page that links to other Web pages (URLs), images,
anchors(bookmarks), sounds or other files.

In the box labeled ‘Enter Hyperlink text’ type the text that you want to link to another Web page, etc. Web
browsers usually display hypertext in a different color (usually blue and underlined) than the rest of the text
and the mousepointer will change to the shape of a hand when it is passed over the hypertext.

In the box labeled ‘Enter URL of Web page or file to link to’ type the URL that you want your hypertext to
link to. For example, it can be a Web page on your own site (dogs.html) or it can be a link to another Web
site (http://www.yahoo.com). You can assign your 15 favorite URLs or filenames so that they will appear
in the pull-down box for easier selection.

Example
If you want to link the words “Click here to go to the bird page” to a Web page named “bird.html”, then
type:

“Click here to go to the bird page” into the ‘Enter Hyperlink text’ input box

and type:

“bird.html” into the ‘Enter URL of Web page or file to link to’ input box.
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After clicking the OK button Web Weaver will insert the following HTML code into your document:

<A HREF="bird.html">bird image</A>

The hyperlink will be displayed in your Web browser as shown below:

If you take a look at thisbird image, then you’ll see exactly what this bird looks like.

Clicking on the words 'bird image' will load the Web page named bird.html.

Targeting
If you are using frames in your Web page, you should specify which frame the linked URL should be
displayed in (otherwise, the URL will be displayed in the same frame that contained the clicked hypertext).
For example, suppose you have a two-framed Web page :frame #1 name being 'MENU' and frame #2 being
'MAINWINDOW'. Your hypertext is in the MENU frame and you want the URL linked to that hypertext
to open in the MAINWINDOW frame when you click on it. If youdon't specify a target frame name, the
linked URL will open in the MENU frame when the hypertext is clicked. So, you must specify the name
'MAINWINDOW' in the Target name input box (for this example).

Anchors and Bookmarks
If you wish to link your hypertext to an anchor (bookmark) in the same Web page or a different Web page,
then you can select the 'Link to a Bookmark?' checkbox and an input box will appear for you to type the
name of the anchor (bookmark). If the destination anchor that you are trying to link to is in the same
document as the hypertext that links to it, you don't need to specify a URL name in the ‘Enter URL of Web
page or file to link to’ input box. If the destination anchor is in a different Web page then you should
specify the URL of that page in the ' Enter URL of Web page or file to link to' input box.

For information on creating a destination anchor (bookmark) in a document,click here.

Special Effects
Clicking on the ‘Special Effects’ tab results in the following being displayed:

Setting these properties allows you to specify text to be displayed in the browser’s status bar when the
mousepointer is moved over the hypertext. You can also specify text (if any) to be displayed when the user
moves the mousepointer away from the hypertext.
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Creating an email link

Uses:
To provide a link which allows the user to submit email to the specified address.

Tag:
<A HREF="mailto: email address "> text </A>

When you select the MailTo menu command found in the HTML extensions menu, the following dialog
box appears:

In the box labeled ‘Enter email address here:’ type your email address. In the box labeled ‘Enter text that
will appear as hypertext on the Web page’ type the text you wish to be displayed as a hyperlink on the Web
page. When the user clicks on the hyperlinked email address in their Web browser they will be able to
write an email to you.

Example
-Type "info@mcwebsoftware.com" in the first input box labeled ‘Enter email address here’.

-Type "Email Us" in the input box labeled ‘Enter text that will appear as hypertext on the Web page’

- Click OK and the following HTML code will be inserted into your Web page:

<A HREF=”mailto:info@mcwebsoftware.com”>Email Us</A>

This is how the link will appear on the Web page:

Email Us

Clicking on the link would result in the user emailing the address info@mcwebsoftware.com.
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CHAPTER 7

Advanced Web Page Design

This chapter will teach you about advanced HTML. The following topics will be
discussed:

• creating Tables
• creating Forms
• creating Frames
• creating Image Maps
• inserting Sound/Multimedia objects
• inserting a Background Sound
• creating a Marquee
• creating Inline Floating Frames
• inserting a Java applet
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Creating Tables with the Table Wizard

Tables are important for presenting tabulated data or laying out advanced Web pages. They allow the
designer more control over where objects, images, and text are placed on the Web page.

The following dialog box appears when you open the Table Wizard:

The first step in creating a table is to specify the number of rows and columns in the table. You can change
the size of the table either using this dialog box or later on when you are specifying the cell contents in the
last step. Be sure not to have extra blank rows and columns in your table unless you want blank
rows/columns represented on your Web page. The maximum number of columns and rows is 100.

Click the NEXT button and move on to Step 2.
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STEP 2: TABLE CAPTION AND BORDER
The table caption and border properties can be set in this step of the Table wizard. They are optional
properties, so you don't have to change them. The default settings are 'no table caption' and 'no table
border'.

Table Caption: If you wish to add a title or caption to your table, type it into the Table Caption box. Your
table caption can be placed at the top or bottom of (underneath) the table. Choose the appropriate
alignment to position the caption in one of these two positions.

Border: You can specify the width of the border which surrounds each table cell. No border will be shown
if BORDER=0. (Default is BORDER=1).

Click the NEXT button and move on to Step 3.
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STEP 3: TABLE DIMENSIONS
Table dimensions, cell spacing and cell padding can be set using this step. These properties are optional
and do not need to be set. The defaults are cell spacing=0 and cell padding=0.

Table Width: This indicates the width of the table. The units of table width can be specified in ens, pixels,
or percentage of screen width. Web Weaver assumes you'll be using percentage of screen width. If you
need to specify the width in ens or pixels you can manually manipulate the code.

Table Height: This indicates the height of the table. The units of table height can be specified in ens,
pixels, or percentage of screen height. Web Weaver assumes you'll be using percentage of screen height.
If you need to specify the height in ens or pixels you can manually manipulate the code.

Cell Spacing:This feature allows you to set the spacing between each cell. If Cell Spacing is equal to 0
then there will be no space (or gap) between the column or row lines. If the Cell Spacing is set to
something other than 0, then each cell will be spaced that distance away from the cells surrounding it in
pixels.

Cell Padding: This feature allows you to set the padding between the cell borders and their contents. If
Cell Padding is equal to 0 then there will be no space (or gap) between the cell borders and the cell
contents(text/object). If the Cell Padding is set to something other than 0, then each cell wall will be spaced
that distance away from the cell's contents in pixels.

Click the NEXT button and move on to Step 4.



Page 73

73

STEP 4: TABLE COLORS
This step allows you to set the table colors including the border colors and background colors. Individual
cell colors can be set using the next step.

Background Color: By selecting a color from the color picker box, the user can set the background color
for the entire table.

Border Color: By selecting a color from the color picker box, the user can set the border color for the
entire table. This must be used with the Border attribute.

BorderColorLight: By selecting a color from the color picker box, the user can set the independent border
color control over one of the two colors used to create a 3D border. Opposite of BorederColorDark. This
must be used with the Border attribute.

BorderColorDark: By selecting a color from the color picker box, the user can set the independent border
color control over one of the two colors used to create a 3D border. Opposite of BorederColorLight. This
must be used with the Border attribute.

When you have finished setting the Table Color Properties, click the NEXT button and the Cell Properties
dialog box will pop up. This box allows the user to enter in table contents and properties for each cell in
the table.
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The Cell Properties dialog box is shown below.

Step 1.
The initial highlighted cell in the table is row 1, column 1 (you can use the mouse, TAB, ENTER or arrow
keys to move around the table). Select the cell you wish to enter information into. Start typing the content
you wish to appear in this cell.

You will notice the input box labeled 'Cell contents'. It contains the contents of the current cell. You can
always return to another cell and edit it's contents in the 'Cell contents' input box. You can also browse for
an image and Web Weaver will insert the HTML code for the image into the selected cell. Once you have
entered contents into the cell go on to step 2.

Step 2.
Cell Properties enhance each and every cell of the table, and affect how the text/object inside each cell is
aligned. You can enter Cell Properties for individual cell items or you can select multiple cells and apply
properties the selected cells. Let's discuss the different properties so you know what each one does.

Column Span: This is another phrase for cell width. If you wish the text/object in a cell to be two cells
wide as opposed to the other cells in the table which are one cell wide, then choose Column Span to be 2
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columns wide. Unlike most spreadsheets, the corresponding cell below the cell with Column Span =2 will
only be 1 cell wide unless you specify that it, too, should have a Column Span of 2.

Row Span:This is another phrase for cell height. If you wish the text/object in a cell to be two cells high
as opposed to the other cells in the table which are one cell high, then choose Row Span to be 2 rows wide.
Unlike most spreadsheets, the corresponding cell adjacent to the cell with Row Span =2 will only be 1 cell
high unless you specify that it, too, should have a Row Span of 2.

Horizontal Alignment: You can specify whether you wish your text/object to be aligned to the left, to the
right or in the center of each cell.

Vertical Alignment: You can specify whether you wish your text/object to be aligned to the top, to the
bottom or in the middle of each cell.

Table Header: Making a cell's contents into a table header will make the contents bold and align the
contents in the center of the cell.

SPECIFYING CELL COLORS:

Background Color: By selecting a color from the color picker box, the user can set the background color
for a specific cell.

Border Color: By selecting a color from the color picker box, the user can set the border color for a
specific cell. This must be used with the Border attribute.

BorderColorLight: By selecting a color from the color picker box, the user can set the independent border
color control over one of the two colors used to create a 3D border. Opposite of BorderColorDark. This
must be used with the Border attribute.

BorderColorDark: By selecting a color from the color picker box, the user can set the independent border
color control over one of the two colors used to create a 3D border. Opposite of BorderColorLight. This
must be used with the Border attribute.

Font face: This sets the Font of the selected cell(s).

Font Size:This sets the Font size of the selected cell(s).

Font color: This sets the Font color of the selected cell(s).

After you enter in the appropriate Cell Properties for the selected cell(s) you can move to other cells to
enter their properties. The cell properties of each cell are retained.

Step 3.
Once you have finished entering in all data into each cell in the table, you can click on the 'Done' button.
This will insert the contents of the Table Maker's table along with the Table Properties into your HTML
document. It's that easy!!
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So, what do all of these HTML tags mean?? Well, let's dissect some of it. The Cell and Table Properties
are pretty self explanatory because I just explained what they mean, but the other table tags need to be
defined. After you input your table into your HTML document, the code should resemble something like
this(I've included all the possible tags to show you where they go):

<TABLE BORDER= 4 CELLSPACING= 2 CELLP ADDING= 5 WIDTH=" 70%"
HEIGHT=" 30%">
<CAPTION ALIGN= top>Example Flow Chart</CAPTION>

<TR>
<TH ROWSPAN=2 VALIGN= Top> Item 1</TH>
<TH VALIGN= Top> Item 2</TH>

</TR>
<TR>

<TD ALIGN= Left > Item 3</TD>
</TR>

</TABLE>

The above example is a table containing three cells. The HTML code for beginning a table is the table
start tag <TABLE>.

The border size is equal to 4. The distance between each cell(cell spacing) is equal to 2. The distance
between the cell walls and the cell contents(cell padding) is equal to 5. The width of the table is equal to
70% of the screen width, and the table height is 30% of the screen height. The table caption is 'Example
Flow Chart' and it is positioned at the top of the table.
The first row begins with the <TR> tag and ends with the </TR> tag. All the HTML code for the cells in
each row must be enclosed with the beginning and ending Row tags <TR></TR>. The first row item (row
1, column 1) is a table header because of the <TH></TH> tags. Its rowspan (cell height) is equal to 2
rows and them contents 'Item 1' are aligned to the top of the cell. The second row item (row 1,column 2) is
also a table header, has a single rowspan, and the contents 'Item 2' are also aligned to the top of the cell.
The ending table row tag </TR> signifies the end of the first row, so we will move on to the second row.
We already know that the first cell in row 1 had a rowspan of 2 rows, so the first cell(row 2, column 1) in
the second row is used by the first cell in row 1. Therefore, there is only one cell item in row 2, and it is
located in row 2, column 2. The second row starts with the beginning row tag <TR> and contains a table
data tag <TD></TD> to signify normal table data in this cell (not a table header, that is). The contents of
this cell 'Item 3' are aligned to the left of the cell. The ending table data tag </TD> signifies the end of that
cell's contents, and the ending table row tag </TR> signifies the end of that row. The HTML code for a
table ends with the ending table tag </TABLE>.
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Creating Forms

Uses:
To create a submission form so that online users can input information and submit it to the author of the
web page which contains the form.

HTML Tag:

<FORM ACTION=” GET” ACTION=” form.cgi”>
<INPUT TYPE=” TEXT ” SIZE=” 30>
<INPUT TYPE=” CHECKBOX ”>

</FORM>

When the Form Wizard is opened, the following dialog box appears:

STEP 1:
The user can choose to use the CGI script that comes with Web Weaver to process the form or they can
specify their own script.

If you are a beginner at making forms, then it is a good idea to select the checkbox that allows you to use
the CGI script included with Web Weaver for processing your form. A CGI script is a program which
processes forms among other things. A form cannot work without a CGI script. The FORM METHOD
and FORM ACTION input boxes will be filled in appropriately. You will have to insert your email
address into the input box that requests it. This tells the form script where to send the form output. When
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someone fills out your form and submits it, it will be sent to this email address. When you have finished
entering your email address, click the 'Insert Form Method/Action' button.See 'Implementing Web
Weaver's CGI script' at the end of this chapter for an explanation on how to make your Form work.

If you have your own CGI script for processing forms, then select the appropriate FORM METHOD.
GET and POST are the two available FORM METHODS that you can choose. They are just different
ways for the Form contents to be processed and sent. It is more common to use the POST method because
it can support more information.

FORM METHOD specifies a method of accessing the action URI. There are two methods: Get
and POST.

FORM ACTION specifies the action URI (Uniform Resource Indicator) for the form.

Type the path and filename of the CGI script into the FORM ACTION input box. When you have finished
entering the FORM ACTION, click the ‘Next' button. Step 2 of the Form creation process will appear:

STEP 2:
This screen allows you to specify the Form input fields that you wish to include in your Web page. The
different types of Form input fields are as follows:

• Text
• TextArea
• Image
• Hidden
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• Checkbox
• Radio
• Password
• Select
• Submit
• Reset

INSERTING FORM FIELDS
Input Field types (not including Pulldown Menu (SELECT) field type)
1. To insert a Form field select an INPUT FIELD TYPE from the list on the left-hand side of Form
Wizard. The different Form fields are explained below:

TEXT: This indicates a single line text entry field. (The default value of the TYPE attribute is
TEXT).

TEXTAREA: This is a multiline text entry field for obtaining information such as comments,
addresses, etc.

PASSWORD: This is a text field as above, except that the value is masked(hidden) as the user
types into the field.

CHECKBOX: This is just what it sounds like. It represents an on/off (yes/no) switch.

RADIO: This also represents an on/off switch, except that only one can be highlighted in a group.
When one is highlighted, the others are blank.

IMAGE: This specifies that an image is displayed and two form fields of input are allowed: the x
and y coordinates of where the image was clicked. When a pixel is chosen, the form is submitted.

HIDDEN: This represents a hidden field where the user doesn't interact with this field. The value
of the field is specified by the author instead.

SELECT (Pulldown Menu): This represents a pulldown menu which offers the user a list of
choices to choose from.

SUBMIT: This represents an input option (a button) which, when selected, submits the contents
of the form.

RESET: This represents an input option (a button) which resets the values of the form to their
original state.

2. In the box labeled ‘Form text’ type text that you wish to appear next to the Form field on the Web page.

3. Each type of Form field has attributes that must be specified. Some attributes are required while others
are optional. The different Form field attributes are explained below:
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Name: This is the name for the form field corresponding to the input type. For example, if you
had a Form field that users were to enter their telephone number into, then an appropriate NAME
for that form field would be 'Phone'.
Value: This is the initial value of the field. It indicates the value to be returned if this particular
option was chosen.
Size:This is the amount of display space allocated to the input field.
Maxlength: This constrains the number of characters that can be entered into an input box.
Checked:This indicates that the initial state is on.
Src: This is the filename of the image file.
Multiple: Indicates that more than one option may be included in the value.
Option: A list item provided in the Selection List Box(SELECT Input type).
Selected: This indicates that this SELECT Input type option is initially selected..
Rows: The number of rows (lines of text) that can be input into the TextArea text box.
Columns: The number of columns (characters) that can be input into the TextArea text box.

In the ‘Attributes’ box (lower right-hand section of Form Wizard) input the required or optional attributes
for the particular Form field. These attributes are different depending on which Form field you are
inserting. When you have completed entering the Form field attributes click the 'Insert Form Field’ button.
Repeat this process for each input field you want in the Form.

4. When you have inserted the last Form field, click the 'Done with Form' button. This is valid procedure
for all input types except for the Pulldown Menu (SELECT) input type.

Inserting the Pulldown Menu (SELECT) Form Field
1. To insert a Pulldown menu (SELECT) Form field into your form, select the ‘Pulldown Menu’ INPUT

FIELD TYPE from the list on the left-hand side of Form Wizard.
2. In the box labeled ‘Form text’ type text that you wish to appear next to the Pulldown menu on the Web

page.
3. Input the ‘Name’ attribute and the ‘Multiple’ and ‘Size’ attributes if necessary. Click on the 'Insert

Form Field' button.
4. Now you are ready to enter in the OPTIONS that will be the menu items in the Pulldown menu. Type

the menu item text into the required ‘Option’ attribute and enter the ‘Selected’ and ‘Value’ attributes if
necessary. Click on the 'Insert Menu Item(s)' button to insert your first menu item. The menu item
attribute boxes will clear so you can input more menu items. Repeat this step to insert more menu
items.

5. When you have entered the last menu item, click on the 'Done with Pulldown menu’ button. You can
now continue inserting more Form fields or finish the Form by clicking the ‘Done with Form’ button.

IMPLEMENTING WEB WEAVER'S CGI SCRIPT FOR PROCESSING YOUR FORM

Unless you are running your own Web server (most of you are not), then youCANNOT test your form
from your local computer. You must upload it and the CGI script to your Internet Service Provider's (ISP)
Web server and then test it on the Web.

There are a few things you must do to make your Form and CGI script work correctly.



Page 81

81

First we'll try using the default settings in the CGI script to see if the work on your ISP's server. Follow
these steps:

1) Make sure your ISP allows custom CGI scripts (made by customers) to reside on their server.
Sometimes ISPs don't want CGI scripts other than their own on their server. They may be afraid of
security risks.

2) After you have completed the HTML form Web page, upload it (in ASCII format) to your Web disk
space provided by your ISP.

3) Upload the file formmail.cgi found in the Web Weaver FORMS directory (in ASCII format) to your
Web disk space provided by your ISP.Make sure this file is in the same folder/directory as your HTML
form Web page on the Web server.

4) Set formmail.cgi file permissions to 755.

Here is an explanation of file permissions.
Web servers have permissions for each file on their hard disks so different users can have access to
files and others cannot. These servers have the capability to restrict users from reading files,
writing to files, or executing files. So there are 3 restrictions for files (each with a corresponding
number):

read(4)
write(2)
execute(1)

There are also 3 user levels that can be restricted: User(you), Group, and World.

What we need to set for our CGI script are permissions that allow everyone to read and execute the
CGI script, but not write to it. Using your FTP client software you can specify the permissions by
selecting the file and select permissions from the pull-down menus or use the right-click pop-up
menu. It may give you a box that lets you set permissions easily. Do this by selecting the
following:

User: Read, Write, and Execute
Group: Read and Execute
World: Read and Execute

If you must type in the UNIX command to change permissions then the syntax would be:

chmod formmail.cgi 755

where the numbers 755 represent the permissions. Here's how we got the numbers. Adding the
numbers together for Read and Execute permissions results in 4+1=5. You want to give yourself
all permissions, so that would be 4+2+1=7. So, to represent these permissions for user, group,
world we would have the following permission numbers: 7 5 5.

5) Now test the Form online and see if it works.
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If you get a server error or the form didn't work, then you may have to change a few things in the CGI
script.

Follow these steps carefully:

A) Check with your ISP and ask them the correct path of the program called PERL on their system. The
first line in the formmail.cgi file calls the PERL program to compile and interpret the formmail.cgi file.
The default path is:

/usr/bin/perl

and the first line in the formmail.cgi file reads:
#!/usr/bin/perl

If the path is different on your ISP's server you must update the first line of formmail.cgi to reflect the
correct path. Open formmail.cgi in Web Weaver and edit the first line. Do not save the file. You must
export it. Select ‘Export | Save as UNIX file’ from the File menu in Web Weaver. Then export/save it as
the same filename: formmail.cgi. Exporting as a UNIX file iscrucial for the script to work.

B) Now upload the formmail.cgi file and reset the permissions as described in step 4 above. Test the online
form. If it still does not work, go on to step C.

C) Check with your ISP and ask them the correct path of the mail program called 'sendmail' on their
system. The 31st line in the formmail.cgi file calls the sendmail program. The default path of the sendmail
program on most systems is:

/usr/lib/sendmail

You should edit the formmail.cgi script to reflect the correct path of the send mail program. The 31st line
in formmail.cgi reads:

$mailprog = '/usr/lib/sendmail';

Remember to Export it from Web Weaver, upload it, and set permissions correctly as described above.
Test the online form again to see if it works.

If it doesn't contact your ISP for further troubleshooting. We cannot determine the problem since we don't
have access to your ISP's settings or server.
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Creating Frames

For a GREAT tutorial on Frames, check out theHelpful Web Sitesweb page!!!

Web Weaver has two Wizards that help you to create Frames. One wizard allows you to create the Frame
layout yourself. The other wizard has custom templates of different Frame layouts so you can easily
choose one that fits your needs. We will discuss the Custom Frame wizard first.

CUSTOM-MADE FRAME WIZARD
Another wizard that Web Weaver offers is the custom-made Frame wizard. If you want a quick way to
make frames, this is it! When you choose the custom-made frames wizard, the following dialog box will
appear:

Simply choose from the list of frame layouts provided by Web Weaver and see it previewed in the wizard
dialog box.

Click the 'Next' button and the following dialog box appears:
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Fill in the appropriate Web page URLs that you wish to appear in the designated frames. Then click the
'Next' button again and Web Weaver provides you with some suggestions if you wish to edit the frame
layout.
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DO IT YOURSELF FRAME WIZARD
This wizard helps you create HTML Frames in your Web page. You can create a maximum of a 3 x 3 grid
of frames. The following dialog box appears when you start the Frame Wizard:

Adjusts the scrollbars to create the desired frame layout. When the desired frame layout has been created,
set additional general frame properties such as Frame borders and the space between frames.

Checking the frame border (FRAMEBORDER) checkbox will cause frame borders to be turned on (this is
the default).

Spacing between frames (or the frame border width) is specified in pixels (FRAMESPACING or
BORDER).

After setting the frame layout and general properties, click the OK button.

The following Frame Properties dialog box appears:
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This dialog box is used to set the properties of each frame. Each frame contains information such as:

• the URL of the Web page that will be displayed in the particular frame,

• the frame name so that each frame can be targeted when another URL points to it. For example, if you
wish to be able to click on hypertext in your Web page and have the new Web page load into a certain
frame, then you must specify which frame the new Web page will load into. This is done by specifying
names for each frame as you create them.

• whether the frame will have scrollbars or not,

• whether the frames can be resized by the user viewing the Web page,

• the margin height and width (in pixels) of each frame.

The Frame's URL is the only value that is required. The other attributes are optional. You should also be
sure to include HTML code for users that have browsers that don't support Netscape Frames. If youdon't
specify this 'NOFRAMES' code, then the browsers will display nothing when viewing your page.
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The HTML code for this is:

<NOFRAMES>

Enter HTML code here for browsers that don't support Frames

</NOFRAMES>

The NOFRAMES code should be placed in the Frame source Web page.

In the Frame Properties dialog box you will see how Web Weaver numbers its frames. Beginning at the
top left with frame number one (1), Frame Wizard numbers from left to right and then from top to bottom.
You can use this as a guide to filling out the correct frame properties for each frame.
Starting with the upper left frame (Frame 1) you should enter the URL of the Web page to appear in this
frame. The other optional attributes can also be entered. When you have finished entering the properties
for this frame click the 'Enter Frame Properties' button to move on to the next Frame. Be aware that if you
make a mistake when entering properties and then click the 'Enter Frame Properties' button youcannot go
back.

After entering in each frame’s properties, Frame Wizard will automatically insert the HTML code for the
Frame layout into the Frame source Web page.
Now create the HTML documents that are referenced in each frame and test it out with your HTML
browser!

Targeting Frames
Names are automatically given to each frame window so that you cantarget particular frames when
creating hyperlinks. Each frame is given an appropriate name. For example, the top frame window is
given the name 'top' and the main content frame window is given the name 'main'.Note that these names
are case-sensitive, so when you are referring to them you must spell them exactly as they are spelled in
the frame source document.

Also note that when targeting frames, the names '_top' and 'top' are very different. 'top' is to be used when
targeting the frames created with Web Weaver's Frame Wizard. '_top' is a special target name which clears
the entire browser screen of frames and displays the URL in the entire browser screen. Other special target
names are _blank, _self, and _parent.

More about targets and Frame names:The main reason for naming frame windows is so you can easily
refer to a specific window. For example, suppose you have two frame windows, one named 'SideMenu'
and the other named 'Main'. The SideMenu frame window contains hyperlinks and the Main frame window
is where you want the Web pages to be displayed when the user clicks on those hyperlinks.

If you don't specify names and targets, the Web pages will display in the same window that the hyperlinks
reside in when the user clicks on them.
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<A HREF="content.html">Click here for content</A>

By specifying a target name in the hyperlink tag, we can force the Web page to be opened in the Main
frame window while the SideMenu frame window doesn't change.

<A HREF="content.html" TARGET="Main">Click here for content</A>

Now that you understand targets and frame names you can continue by clicking 'Done' and the new
document with the frame layout will be created for you!
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Sound/Multimedia Object

Use:
The Sound/Multimedia object tag is used to insert sounds, animations, videos, and other multimedia files
into your Web page. Internet Explorer 3.0 and above support this tag. Netscape 3.0 and above support
this tag. Also reference IE's proprietaryBGSound tagfor inserting sounds into Web pages.

HTML Tag:

<EMBED SRC=" ding.wav" WIDTH=” 100” HEIGHT=” 200” ALIGN=”Middle”
CONTROLS=” SMALLCONSOLE ” AUTOSTART=” TRUE” LOOP=” TRUE”
ALT=" This is a ding sound">

When the Sound/Multimedia Object menu item is selected, the following dialog box appears:

Inserting a Sound/Multimedia Object
In the box labeled 'Enter URL or filename of object to embed' type the filename of the sound/multimedia
file you wish to play. You can also use the Browse button to search your hard drive for the file.

In the input box labeled ‘ALT text ’ type a description of the object. This description will be displayed in
place of the object in any Web browsers that don't support the <EMBED> HTML tag.

Set the object’swidth and height by inputting the number of pixels in the Width and Height input boxes.

You can provide a set of buttons on your Web page to control playback of the sound/multimedia object.
Specify small controls, large control console or hidden controls.

Alignment determines how surrounding text and images will be aligned with the object. Specify top,
middle or bottom in the box labeled ‘Align’. (Bottom is the default).

Autostart tells the browser to automatically begin playing the sound/multimedia object when the Web page
is loaded.
Loop the soundtells the browser to infinitely repeat the sound/multimedia object.



Page 90

90

Background Sound

Use:
The BGSound tag is used to play a sound when your Web page loads in a browser. The sound can play
once or can repeat a specified number of times. Sounds can be either samples (.wav or .au format) or MIDI
files (.mid format). Only Internet Explorer supports this tag. Refer toSound/Multimedia Objectfor a more
universal tag for inserting sounds or download our product J-Perk from http://www.mcwebsoftware.com to
insert sounds on your Web page.

Tag:
<BGSOUND SRC="music.wav " LOOP=Infinite >

The following figure shows the Background Sound dialog box:

Inserting a Sound
To specify a background sound type the name of the sound file (or browse for it) into the input box labeled
‘Background sound filename’.

Specify how many times the sound file will repeat (play again) in the box labeled ‘Loop’. The range is
from 'None' (play once) to an 'Infinite' loop which will repeat the sound file continuously.

This tag is only supported by Microsoft's Internet Explorer. Netscape does not support it. Refer to
Sound/Multimedia Object for a more universal tag for inserting sounds.

Marquee

Use:
The Marquee tag is used to create a scrolling text ticker on your Web page. Text can scroll from right to
left or from left to right. Only Internet Explorer supports this tag. For scrolling marquees that work on all
browsers, download our product J-Perk from http://www.mcwebsoftware.com.

Tag:
<MARQUEE DIRECTION=LEFT WIDTH=350 HEIGHT=20 SCROLLAMOUNT=1

SCROLLDELAY=5 BGCOLOR=0000FF >text </MARQUEE>



Page 91

91

The following figure shows the Marquee dialog box:

In the first input box marked ‘Enter text you wish to scroll in your marquee’, type the text you wish to
scroll across the screen.

The remaining attributes in the dialog box are ALL optional, but they provide a great deal of control
over your scrolling text.

• The Behavior attribute specifies how the text should behave. There are three possible values for
behavior: SCROLL, SLIDE, and ALTERNATE. Scroll (the default) causes the text to start at one
side of the screen, scroll all the way across and completely off the screen, and then start again. Slide
causes the text to start completely off one side, scroll across the screen and stop as soon as the text
touches the other side of the screen. Alternate causes the text to bounce back and forth within the
marquee.

• The Align attribute specifies that the text around the marquee should align with the TOP, MIDDLE or
BOTTOM of the marquee.

• The Loop attribute specifies the number of times a marquee will loop when activated. If the attribute
Loop=1 or if Loop=Infinite is used it will loop indefinitely. Loop can be set to any number.

• The Height and Width attributes specifies the height of the marquee, either in pixels or as a percentage
of the screen height/width.

• The Vspace attribute specifies the top and bottom margins for outside of the marquee in pixels.



Page 92

92

• The Hspace attribute specifies the left and right margins for outside of the marquee in pixels.

• ScrollAmount specifies the number of pixels between each successive draw of the marquee text.

• ScrollDelay specifies the number of milliseconds between each successive draw of the marquee text.

• Background color specifies the background color for the marquee either as an RGB code or as a
primary color name (red, blue, etc.)

This tag is only supported by Microsoft's Internet Explorer. Netscape doesn't support it.

Floating Frames

Use:
Using the Internet Explorer IFRAME tag, the author can create Web pages with embedded or inline
frames. A floating frame can be thought of as a 'picture within a picture'. They are very much like images
in your Web page. The frame can be placed anywhere on your Web page (like an image) and any HTML
document(Web page) can be loaded into the frame. Only supported by Microsoft's Internet Explorer.

Tag:
<IFRAME SRC=" http://www.mcwebsoftware.com" WIDTH= 100HEIGHT= 200>

The following figure shows the Floating Frames dialog box:
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The following properties are supported by the floating frame:

REQUIRED

Source URL: This is the filename or Web address (URL) of the Web page you wish to display in the
floating frame.

Width: Specify the width (in pixels or percentage of browser screen width) of the floating frame window.

Height: Specify the height (in pixels or percentage of browser screen height) of the floating frame window.

ALTernative text: Used to replace the floating frame in Web browsers that don't support floating frames.
This is the text that you wish to appear if people are not able to see the floating frame.

OPTIONAL

Horizontal Space:This controls the horizontal space to the left and right of the floating frame. This
prevents neighboring text from pressing up against the left and right sides of the frame. Specified in pixels.

Vertical Space:This controls the vertical space above and below the floating frame. This prevents
neighboring text from pressing up against the top and bottom of the frame. Specified in pixels.

Frame Border Size:This controls the thickness of the border around the floating frame. Setting
BORDER=0 will show no border.

Scroll bars: This specifies whether or not the floating frame has scroll bars to allow the user to scroll
horizontally or vertically if the frame dimensions are smaller than the Web page that it displays.

Align: To align neighboring text and images with the floating frame.

Left/Right: These alignments provide a floating image type. Aligning left will float the frame down and
over into the left margin, and neighboring text will wrap around frame. Align=right aligns the floating
frame with the right margin and text wraps around the left hand side of the frame.

This tag is only supported by Microsoft's Internet Explorer. Netscape does not support it.
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Java Tags

Use:
Allows you to incorporate Java applets in your Web page.

Tag:
<APPLET CODE="Animate.class " CODEBASE="/apps " ALT=" A Java applet
goes here " ALIGN= Middle WIDTH=450 HEIGHT=250 VSPACE=44
HSPACE=44>
</APPLET>

The Java Applet dialog box is shown below:

APPLET PROPERTIES
In the box labeled ‘Java applet filename’ type the filename of your Java applet class file. For example, if
the name of the Java applet you wish to insert into your HTML document is Animate (or Animate.class),
type 'Animate.class' into the input box.

In the box labeled ‘Alternative text for browsers not supporting Java’ type text to appear in your Web Page
(HTML document) in place of the Java applet if the browser being used does not support Java. You could
type “A Java applet goes here. Your browser doesn’t support Java.” into this input box, and anon-Java
browser will display this text instead of the Java applet.

In the box labeled ‘Codebase (Applet directory)’ type the name (if any) of the folder(directory) that
contains the Java applet class file(s). If the applet class file(s) is not in the same directory as your Web
page (HTML document), then you must specify the directory. For example, if your Web page document
which contains the applet HTML tags is in the directory /HTMLdocs and your Java applet class file(s) is in
the directory /HTMLdocs/apps, then you should specify 'apps/' as the Codebase.
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Parameters
The parameter tag is used to specify different parameters (variables) for the Java applet. For example, if
the Java applet requires you (the Web page author) to specify the applet font and font size, then you must
specify it using parameters.

HTML Tag: <PARAM ETER Name="Font" Value=" Courier">

To insert a parameter for the Java applet, click on the ‘Insert’ button in the Parameters section of the dialog
box. The following parameter dialog box will appear:

It requires that you specify the name and value of the parameter. For example, if your Java applet allows
you to specify a sound file as one of its parameters and a valid parameter NAME is “Sound” and a valid
parameter VALUE is any sound filename then:

Type “Sound” in the box labeled ‘Parameter name’ and type a sound filename (such as ding.au) in the box
labeled ‘Parameter value’. Then click the ‘Insert’ button on the Parameter dialog box to insert it.
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LAYOUT

Clicking on the ‘Layout’ tab displays the following screen:

The height, width, Vspace and Hspace control the size and layout of your Java applet. Hspace (Horizontal
Space) and Vspace (Vertical Space) determine the amount of screen space is between the applet and
neighboring text and images.

The alignment acts just as the alignment for an image. The alignment preview box will demonstrate how
each alignment attribute works.
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Creating Imagemaps

Uses:
To create a client-side image map which allows the user to associate different links with different areas on
an image.

HTML Tag:

<MAP NAME="Map1">
<AREA SHAPE=” Circle” COORDS=" 25,124 60" HREF=" http://www.tiac.net">
<AREA SHAPE=” Rect” COORDS=" 57,89 168,226" HREF=" http://www.yahoo.com">
<AREA SHAPE=” Poly” COORDS=" 57,89 168,226 485,654" HREF=" http://www.lycos.com">
</MAP>

When the ImageMap Wizard is opened, the following dialog box appears:

IMAGE FILENAME AND MAP NAME:
Search for the image using the browse button. When you have found the image in the browse dialog box,
select it and click the OK button. The image filename will be displayed in the box labeled ‘Select image:’
and the image will be displayed on the lower half of the Imagemap dialog box.

In the box labeled ‘Image Map name’ type the name of the map. It can be any name of your choice.
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Click the ‘Next’ button to proceed to the next step. The following screen will be displayed:

CREATING HOTSPOTS:
To begin drawing hotspots on your image, select one of the shapes (rectangle, circle or polygon/triangle) in
the shape box (located on the left side of the Imagemap dialog box. After selecting a shape, text will be
displayed at the top of the dialog box instructing you where to click on the image to create your hotspots.

- A circle shape requires you to click on the circle’s center and then on any point on its radius.
- A rectangle shape requires you to click on the top left corner of the rectangle and then the lower
right corner.
- A polygon/triangle shape requires you to click on the vertices of the polygon. Web Weaver has a
maximum of seven (7) vertices for the polygon shape.

When you have completed drawing the shape on your image the ‘Specify URL to link to’ dialog box will
appear:
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LINKING HOTSPOTS TO WEB PAGES:
This dialog box allows you to specify the Web page URL you wish to link to the hotspot. In the box
labeled ‘Link the hotspot to this URL’ insert the URL or filename to link to the hotspot shape you have just
created.

For example, if you draw a rectangular shaped hotspot, you can specify the URL "http://www.yahoo.com".
When the user clicks on this particular area on your imagemap in a Web browser, he/she will be linked to
the Yahoo web site.

Targeting Frames
If you need to specify a target frame (when using HTML frames) you can do so by specifying it in the
'Target Frame' box. When the hotspot is clicked the browser will open the specified URL in the specified
frame.

Undo
If you make an error while creating a hotspot you can click the Undo button and Web Weaver will remove
the error.

Once you have created all of your hotspots click the Done button to finish.

About Imagemaps
What is an image map, you ask? Well, I'm sure you've encountered them while browsing the Web. Image
maps are images that contain different areas (hotspots) that can be clicked on and a different action or Web
page is assigned to each hotspot. Clicking on these different hotspots will load a different Web page.
Many sites are using image maps on their introduction pages instead of using text tables of contents. They
may have one image that contains smaller images(icons) which represent the different menu items to
choose. For example, one Web page contains a bookshelf with books having different titles, each book
being a hotspot. Each book (hotspot) is assigned to another Web page, so when you click on the cook book
it takes you to a page with recipes. Clicking onA Tale of Two Citieswill link you to a Web page on the
Classics, and so on.

Differences between Client-side and Server-side Image maps
In a server side image map, the user clicks on the image map in their browser and the coordinates are sent
to the server on which the image map resides. A program on the server gathers the information, processes
it and then sends the URL associated with that image map area to your Web browser.
Client side image maps are much better because you can save a step. The browser on your hard drive
processes the clicked area and its coordinates and automatically sends you (the user) to the associated
URL. The server and its programs needed to process the image map are no longer necessary. This makes
your life easier. Client side image maps are different from server side image maps in that they do not need
special programs on the server to make them work.

There are a few things that make up an image map and allow it to work.

1. Any graphic image.
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2. For Client Side Image maps- Image map HTML code in your Web page (HTML document) tells
your Web browser which hotspot is linked to which location, image, sound, etc. The map HTML code
just consists of Web addresses (URLs) and the corresponding pixel coordinates that define the
respective hotspot. Here's an example:

<MAP NAME="Map1">
<AREA SHAPE=Circle COORDS="25,124 60 " HREF=" http://www.tiac.net ">
<AREA SHAPE=Rect COORDS="57,89 168,226 " HREF=" http://www.yahoo.com ">
<AREA SHAPE=Poly COORDS="57,89 168,226 485,654 " HREF=" http://www.lycos.com ">
</MAP>

For Server Side image maps- A MAP file that tells your Web server which hotspot is linked to which
location, image, sound, etc. The map file just consists of Web addresses (URLs) and the corresponding
pixel coordinates that define the respective hotspot. For example,

rect http://www.website1.net/index.html 0,0250,123
rect http://www.website2.net/users/jack/mypage.html250,123 400,123

The rect stands for a rectangular shaped hotspot. Other shapes like circles, polygons, and ellipses are
supported as well. Map files usually end in the extension .map or .imp.

Server side image maps also need:HTML code in the Web document to tell the server to process the
image as an imagemap. This code looks roughly like the following:

<A HREF=" /cgi-bin/imagemap/~mmcconne/yourimage.map"><IMG SRC=" yourimage.gif"
ISMAP></A>

The/cgi-bin/imagemappart of that HREF reference tells the browser where the script is which will
process the imagemap. The/~mmcconne/yourimage.mappart tells the server where the map file is
located(the directory and filename). In this case, it is located in my personal directory.

Your server must have a cgi-bin (Common Gateway Interface) script file which can interpret the image
map file and be able to display the image as a mapped image on the Web page. Most Internet service
providers have these cgi-bin scripts built-in so you don't have to program them yourself. All you need
to know is the name and directory of the cgi-bin file for the image map, and you can either ask your
Internet service provider or look at other people's Web pages who use the same Internet service
provider and find one that has an imagemap. When you find a page that has one, view the source code
and copy the HTML code and cgi-bin file/path that is used to interpret the image map file. Remember
that the Web page you are copying this information from should be hosted by the same Internet service
provider as you.
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CHAPTER 8

HTML Reference

This chapter includes definitions and explanations of all HTML tags. An alphabetical
listing of the tags is useful as an index to the following categories:

• Alphabetical Listing of HTML tags
• Structure tags
• Paragraph/Text element tags
• Logical style tags
• Physical tags
• Math tags
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Alphabetical Listing of HTML Tags
Below is the list of HTML tags which are included in Web Weaver. HTML 2.0, HTML 3.0, Internet
Explorer and Netscape extensions are included in this list.

^ ^ Superscript [HTML 3.0 Math] Page 51
_ _ Subscript [HTML 3.0 Math} Page 51
{ } Box [HTML 3.0 Math] Page 51
<!-- --> Comment Page 42

A

<ABBREV></ABBREV> Abbreviation [HTML 3.0] Page 45
<ABOVE> Above [HTML 3.0 Math] Page 51
<ACRONYM></ACRONYM> Acronym [HTML 3.0] Page 45
<ADDRESS></ADDRESS> Address Page 42
ALIGN= Ali gnment Page 69
ALINK= Active Link Color [Netscape Extension] Page 38
ALT= Alternate Image Text Page 69
<ARG></ARG> Argument [HTML 3.0] Page 45
<ARRAY></ARRAY> Array [HTML 3.0 Math] Page 51
<ATOP> Atop {HTML 3.0 Math] Page 51
<AU></AU> Author [HTML 3.0] Page 45

B

<B></B> Bold Page 49
BACKGROUND= Background Image [Netscape Extension] Page 94
<BANNER></BANNER> Banner[HTML 3.0] Page 40
<BASE> Base Page 40
<BASEFONT SIZE=> Basefont Size[Netscape Extension] Page 94
<BELOW> Below [HTML 3.0 Math] Page 51
BGCOLOR= Background Color [Netscape Extension] Page 94
<BLINK></BLINK> Blink [Netscape Extension] Page 94
<BLOCKQUOTE></BLOC Blockquote Page 42
<BODY></BODY> Body Page 40
BORDER= Image Border [Netscape Extension] Page 69
BORDER= Table Border[HTML 3.0 Table] Page 108
<BOX></BOX> Box [HTML 3.0 Math] Page 51
<BQ></BQ> Blockquote[HTML 3.0] Page 42
<BR> Line Break [Netscape Extension] Page 94
<BT></BT> Bold Upright Font [HTML 3.0 Math] Page 51
<BYLINE></BYLINE> B yline [HTML 3.0] Page 42

C
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CAPTION Table Caption [HTML 3.0 Table] Page 108
CELLPADDING= Table Cell Padding [HTML 3.0 Table] Page 108
CELLSPACING= Table Cell Spacing [HTML 3.0 Table] Page 108
<CENTER></CENTER> Center[Netscape Extension] Page 94
CHECKBOX Form Input Type Page 61
CHECKED Form attribute Page 61
<CHOOSE></CHOOSE> Choose[HTML 3.0 Math] Page 51
<CITE></CITE> Citation Page 45
CLEAR= Clear [Netscape Extension] Page 94
CLASS= Class
<CODE></CODE> Code Page 45
COLS= Number of Columns in a Form Textarea Page 61
COLSPAN= Table Column Span[HTML 3.0 Table] Page 108
<CREDIT></CREDIT> Credit[HTML 3.0] Page 45

D

<DD> Descriptive List Text Page 81
<DEL></DEL> Deleted Text[HTML 3.0] Page 45
<DFN></DFN> Defining Instance(Definition) Page 45
DINGBAT= Dingbats[HTML 3.0]
<DIR></DIR> Directory List Page 84
<DL></DL> Descriptive List Page 81
<DT> Descriptive List Topic Page 81

E

<EM></EM> Emphasis Page 45
EMBED Embedded Item Page 60

F

FIG= Figure [HTML 3.0] Page 69
<FN></FN> Footnote[HTML 3.0] Page 45
<FONTSIZE=></FONT> Font Size[Netscape Extension] Page 94

H
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<H1></H1> Heading 1 Page 42
<H2></H2> Heading 2 Page 42
<H3></H3> Heading 3 Page 42
<H4></H4> Heading 4 Page 42
<H5></H5> Heading 5 Page 42
<H6></H6> Heading 6 Page 42
<HEAD></HEAD> Head Page 40
HEIGHT= Image/Object/Table cell Height [Netscape Extension] Page 108
HIDDEN= Form Input Type Page 61
<HR> Horizontal Rule Page 42
HSPACE= Horizontal Space [Netscape Extension] Page 69
<HTML></HTML> HTML Page 40

I

<I></I> Italic Page 49
ID ID
IMAGE Form Input Type Page 61
IMG= Image Page 69
<IMG=' '> Inline Image Page 69
<INPUT> Form Input tag Page 61
<INS></INS> Inserted Text[HTML 3.0] Page 45
<ISINDEX> Isindex Page 40
ISMAP Image map Page 61
<ITEM> Array Item[HTML 3.0 Math] Page 51

K

<KBD></KBD> Keyboard Page 45

L

LANG= Language
<LI> List Item Page 77
LINE BREAK <BR> Page 92
<LINK> Lin k Page 40
LINK= Unvisited Link Color [Netscape Extension] Page 38
<LISTING></LISTING> Listing Page 42
<LIT></LIT> Literal [HTML 3.0] Page 42

M
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<MAILTO> Mailto [Netscape Extension] Page 94
<MATH></MATH> Math Equation [HTML 3.0 Math] Page 51
<MAXLENGTH=> Max. length of text in Form Page 61
<MENU></MENU> Interactive Menu Page 83
<MULTIPLE> Multiple entries in a Form Page 61

N

<NAME=> Name attribute in Forms Page 61
<NEXTID> Next ID Page 40
<NOBR></NOBR> No Break[Netscape Extension] Page 94
NOSHADE Unshaded Horizontal Rule[Netscape Extension] Page 109
<NOTE></NOTE> Note[HTML 3.0] Page 45
NOWRAP Prevents Word wrap Page 42

O

<OL></OL> Numbered/Ordered List Page 79
OPTION Form option element within a listbox Page 61
<OVER> Over [HTML 3.0 Math] Page 51

P

<P ALIGN=></P> Aligned Paragraph [HTML 3.0] Page 42
<P> Paragraph Page 42
<P></P> Paragraph [HTML 3.0] Page 42
PASSWORD Form Input Type Page 61
<PERSON></PERSON> Person Page 45
<PLAINTEXT> Plaintext Page 42
<PRE></PRE> Preformatted Text Page 42

Q

<Q></Q> Inline Quote Page 45

R
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RESET Form Input Type Page 61
<ROOT>#<OF></ROOT> Root[HTML 3.0 Math] Page 51
<ROW> Array Row[HTML 3.0 Math] Page 51
ROWS= Number of Rows in a Form Textarea Page 61
ROWSPAN= Table cell row span[HTML 3.0 Table] Page 108

S

<S></S> Strikethrough [HTML 3.0] Page 49
<SAMP></SAMP> Sample Page 45
<SELECT></SELECT> Form input type(selection listbox) Page 61
SELECTED Initial selection in a Form selection listbox Page 61
SIZE= Size of Horizontal Rule[Netscape Extension] Page 109
SIZE= Size of Form Input Page 61
<SQRT></SQRT> Square Root[HTML 3.0 Math] Page 51
SRC= Image sourcepath/filename Page 69
<STRONG></STRONG> Strong Emphasis Page 45
<SUB></SUB> Subscript [HTML 3.0] Page 49
SUBMIT Form Input Type Page 61
<SUP></SUP> Superscript [HTML 3.0] Page 49

T

<T></T> Upright Font [HTML 3.0 Math] Page 51
<TAB> Tab [HTML 3.0] Page 42
<TABLE></TABLE> Table[HTML 3.0 Table] Page 108
<TD> Table Data[HTML 3.0 Table] Page 108
<TEXT></TEXT> Text [HTML 3.0 Math] Page 51
TEXT= Text Color [Netscape Extension] Page 38
TEXT= Form Input Type Page 61
TEXTAREA= Form Input Type Page 61
<TH> Table Header[HTML 3.0 Table] Page 108
<TITLE></TITLE> Title Page 40
<TR> Table Row[HTML 3.0 Table] Page 108
<TT></TT> Typewriter Text Page 49
TYPE= Bullet Type(in Bulleted List) Number Type Page 76
TYPE= Number Type(in Numbered/Ordered List) [Netscape Page 76
TYPE= Input Type(in Forms) Page 61

U
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<U></U> Underline [HTML 3.0] Page 49
<UL></UL> Unordered List Page 76

V

VALUE= Initial value of form input Page 61
<VAR></VAR> Variable Page 45
VLINK= Visited Link Color [Netscape Extension] Page 38
VSPACE= Vertical Space [Netscape Extension] Page 69

W

<WBR> Word Break[Netscape Extension] Page 94
WIDTH= Image/Object/Table cell Width Page 84



Page 108

108

Structure Tags

Structure element tags describe the functions of the Web page to the browser software. They are usually
not seen by the person browsing the page, but are used to tell the browser software important information
about the Web document. See below for descriptions of each Structure element tag:
______________________________________________________________________________

• Banner - <BANNER></BANNER> [HTML 3.0]
• Base - <BASE>
• Body - <BODY></BODY>
• Head - <HEAD></HEAD>
• HTML - <HTML></HTML>
• IsIndex - <ISINDEX>
• Link - <LINK> [HTML 3.0]
• NextID - <NEXTID>
• Title - <TITLE></TITLE>

______________________________________________________________________________

BANNER - (Rarely used)
This inserts the HTML tag for a banner. Banners are static displays which remain stationary on the
browser screen. They do not scroll up or down with the Web page as it is being viewed. Banners are good
for advertising, displaying logos, making stationary image toolbars, etc.

Tag: <BANNER>text,images,etc </BANNER>

BASE - (Rarely used)
This inserts the HTML tag to specify the name of the file in which the current document is stored. This is
useful when link references within the document do not include full pathnames.

Tag: <BASE> filename

BODY - (Frequently used)
This inserts the HTML tag to signify the body element of the HTML document. The body contains all the
tags for the final appearance of the document when viewing it through a browser.

Tag: <BODY> body elements(main part of document) </BODY>

HEAD - (Frequently used)
This inserts the HTML tag for the head elements such as TITLE, ISINDEX, NEXTID, LINK, and BASE.

Tag: <HEAD> head elements </HEAD>

HTML - (Frequently used)
This inserts the HTML tag to signify the beginning and end of the HTML document. This tag informs
browsers that they are reading an HTML document and that it should be interpreted as one.

Tag: <HTML> entire document </HTML>
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ISINDEX - (Rarely used)
This inserts the HTML tag to specify a searchable index file. In other words, it tells the browser that this
document is 'searchable'. A search prompt and input box will be placed on-screen wherever you specify
<ISINDEX> in your HTML document. Typing text-to-be-searched-for in the input box and clicking on the
Search button will result in the server being queried for the specified information, and hopefully a response
from the server. Yahoo is an example of a searchable index which responds to the user with many
examples of Web pages that contain the text that the user searched for..

Tag: <ISINDEX>

LINK - (Rarely used)
This inserts the HTML tag to specify relationships to other documents. Link has the attributes REL, REV,
and HREF.

REL defines the relationship between the active document and another document
REV defines a reverse relationship between another document and the active document.
HREF links to the URL of another document.

Tag: <LINK REV= HREF=>

NEXTID - (Rarely used)
This inserts the HTML tag to set a variable value.

Tag: <NEXTID> variable name

TITLE - (Frequently used)
This inserts the HTML tag for the document title. This tag is restricted to the head element discussed
above, and it represents the title of the URL. If text has been selected, choosing this menu item causes the
selected text to be surrounded by the beginning and ending title tags as shown below:

Tag: <TITLE> Selected Text </TITLE>

If no text has been selected, choosing this menu item causes the title tag to be inserted into the main text
with the cursor placed in between the beginning and ending title tags so the title text will be ready to be
typed area as shown below:

<TITLE> | </TITLE>
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Paragraph/Text Element Tags

See below for descriptions of each Paragraph/Text element tag:
______________________________________________________________________________

• Headings - <H1></H1>
• Address - <ADDRESS></ADDRESS>
• Aligned Paragraph - <P ALIGN=></P> [HTML 3.0]
• Blockquote - <BLOCKQUOTE></BLOCKQUOTE> or <BQ></BQ>
• Byline - <BYLINE></BYLINE> [HTML 3.0]
• Comment - <!-- -->
• Horizontal Rule - <HR>
• Line Break - <BR>
• Listing - <LISTING></LISTING>
• Literal - <LIT></LIT> [HTML 3.0]
• Paragraph - <P>
• Plaintext - <PLAINTEXT></PLAINTEXT>
• Preformatted Text - <PRE></PRE>
• Tab - <TAB> [HTML 3.0]

______________________________________________________________________________

HEADINGS - (Frequently used)
The Insert Headings menu items are equivalent to the Headings buttons located on the top toolbar. When
any of them is selected the following tag is inserted in the active text document (depending on which
heading number is selected).

Selecting text in the active document and then choosing the Insert Heading menu item will result in the
selected text being surrounded by the HTML heading tag in the document. Otherwise the heading tag will
be inserted where the cursor is, and the cursor will move to the middle of the tag so the user can type the
text that is to have that heading value.

Tag: <H1> | </H1>

ADDRESS - (Sometimes used)
Used to insert information regarding your email address or where you can be reached.

Tag: <ADDRESS>text </ADDRESS>

The text which is enhanced by the ADDRESS tags will appear italic in most browsers.
When this button or menu item is selected, the above tag is inserted into the active document.

ALIGNED PARAGRAPH - (Frequently used)
Indicates the beginning of a new paragraph. This differs from HTML 2.0 paragraph tag in that it has a
closing </P> tag to indicate the end of a paragraph. Also the this version of the paragraph tag can include
attributes within the opening tag such as: ALIGN, CLASS, CLEAR, ID, LANG, and NOWRAP. Below is
an example of the paragraph tag using the Align attribute. The paragraph enclosed within the <P></P>
tags would be aligned to the right margin, left margin, center of the page or justified to both margins
depending on which attribute value was used.

Tag: <P ALIGN=></P>
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BLOCKQUOTE - (Sometimes used)
Used to insert text quoted from another source. Different from an inline quote in that it creates it's own
paragraph. Usually a larger quote.

Tag: <BLOCKQUOTE>text </BLOCKQUOTE>
or <BQ>text </BQ>

BYLINE - (Rarely used)
Unsure if this tag is included in the HTML 3.0 specification.

COMMENT - (Frequently used)
Used to insert a comment into the HTML document that won't be seen in a viewer. Used for tag
commentary.

Tag: <!-- text -->

HORIZONTAL RULE - (Frequently used)
Inserts a horizontal line across the page as shown below:
______________________________________________________________________________

Tag: <HR>

See also the Netscape Horizontal Rule

LINE BREAK - Shortcut Key: CTRL-K - (Frequently used)
Inserts a line break when placed in a text string. The text following the <BR> tag is shifted one line down
and begins at the left margin of the page.

Tag: <BR>

LISTING - (Rarely used)
Used to insert an example computer listing. Embedded tags are ignored, but embedded tabs are allowed.

Tag: <LISTING> text </LISTING>

LITERAL - (Rarely used)
Unsure if this tag is included in the HTML 3.0 specification.

PARAGRAPH - (Frequently used)
Indicates the beginning of a new paragraph.

Tag: <P>
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PLAINTEXT - (Obsolete)
Used to insert text with a plain format. Obsolete tag.

Tag: <PLAINTEXT>text </PLAINTEXT>

PREFORMATTED TEXT - (Sometimes used)
Used to insert preformatted text that the user wants to be displayed 'as is'. The preformatted text may
include embedded tags, but not all tags are permitted.

Tag: <PRE> text </PRE>

TAB - (Rarely used)
Used to set tab stops in a document so a user can indent text to specified tab stops. The user can specify
how many spaces he/she wishes to indent by using the INDENT attribute. Typing a number after the equal
sign will result in an indentation of that number of ens. An en is one- half the font size. Using the ID and
TO attributes a user can create a named tab stop. The ID attribute is used to name the tab stop and the TO
attribute is used to jump to any named tab stop. For example, if the user typed:

My dog is my favorite pet<TAB ID="dogtab"> because he is my best
friend.

this would set the name of the tab stop to 'dogtab'. Then typing:

<TAB TO="dogtab">He eats a lot of food.

would result in tabbing to the tab stop named 'dogtab'.

The align attribute is also allowed within the <TAB> tag in order to create left, center and right tab stops.
Tag: <TAB>

<TAB INDENT=>
<TAB ID=>
<TAB TO=>
<TAB ALIGN=>
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Logical Style Tags

Logical style tags indicate how text is to be used by the browsing software. These tags do not indicate how
the text will appear even though the appearance of the text may be different for each logical style tag. The
difference between physical and logical style tags is that all browser software will display text enhanced by
physical tags in the same way. Browsers may display text that is enhanced by logical tags in different
ways even though the same tag is being used. One browser may display text enhanced with the Emphasis
tag as bold, whereas another browser may show the text with the same HTML code as a larger font.
Logical tags are used to let the browser software know what the tagged text is going to be used for. See
below for descriptions of each Logical style tag:
______________________________________________________________________________

• Abbreviation - <ABBREV></ABBREV> [HTML 3.0]
• Acronym - <ACRONYM></ACRONYM> [HTML 3.0]
• Argument - <ARG></ARG> [HTML 3.0]
• Author - <AU></AU> [HTML 3.0]
• Citation - <CITE></CITE>
• Code - <CODE></CODE>
• Credit - <CREDIT></CREDIT> [HTML 3.0]
• Defining Instance - <DFN></DFN>
• Deleted Text - <DEL></DEL> [HTML 3.0]
• Emphasis - <EM></EM>
• Footnote - <FN></FN> [HTML 3.0]
• Inline Quote - <Q></Q> [HTML 3.0]
• Inserted Text - <INS></INS> [HTML 3.0]
• Keyboard - <KBD></KBD>
• Note - <NOTE></NOTE> [HTML 3.0]
• Person - <PERSON></PERSON> [HTML 3.0]
• Sample - <SAMP></SAMP>
• Strong - <STRONG></STRONG>
• Variable - <VAR></VAR>

______________________________________________________________________________

ABBREVIATION - (Rarely used)
This logical tag modifies surrounded text so it is recognized by the browser to be an abbreviation.
Selecting the Abbreviation menu item after selecting text in the current document will result in the
highlighted text being surrounded by the ABBREV tag.

Tag: <ABBREV> text </ABBREV>

ACRONYM - (Rarely used)
This logical tag modifies surrounded text so it is recognized by the browser to be an acronym. Selecting
the Acronym menu item after selecting text in the current document will result in the highlighted text being
surrounded by the ACRONYM tag.

Tag: <ACRONYM>text </ACRONYM>

ARGUMENT - (Rarely used)
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Unsure if this tag has made it into the HTML 3.0 specification.

AUTHOR - (Rarely used)
This logical tag modifies surrounded text so it is recognized by the browser to be the name of an author.
Selecting the Author menu item after selecting text in the current document will result in the highlighted
text being surrounded by the AU tag.

Tag: <AU> text </AU>

CITATION - (Rarely used)
This logical tag modifies surrounded text so it is recognized by the browser to be a citation or a brief quote.
Selecting the Citation menu item after selecting text in the current document will result in the highlighted
text being surrounded by the CITE tag.

Tag: <CITE> text </CITE>

CODE - (Sometimes used)
This logical tag modifies surrounded text so it is recognized by the browser to be a sample of code (usually
used to display lines of computer programming code in a fixed-width font such as Courier). Selecting the
Code menu item after selecting text in the current document will result in the highlighted text being
surrounded by the CODE tag.

Tag: <CODE> text </CODE>

CREDIT - (Rarely used)
This logical tag modifies surrounded text so it is recognized by the browser to be a credit or reference to an
author/artist, and is usually included WITHIN the blockquote tags. Selecting the Credit menu item after
selecting text in the current document will result in the highlighted text being surrounded by the CREDIT
tag.

Tag: <CREDIT> Person's name </CREDIT>

Enclosed within blockquote tags:
<BQ>
Quote
<CREDIT> Person's name </CREDIT>
</BQ>

DEFINING INSTANCE (Definition) - (Rarely used)
This logical tag modifies surrounded text so it is recognized by the browser to be a word/phrase that is to
be defined or has been defined. Selecting the Defining Instance menu item after selecting text in the current
document will result in the highlighted text being surrounded by the DFN tag.

Tag: <DFN> text </DFN>

DELETED TEXT - (Rarely used)
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This logical tag modifies surrounded text so it is recognized by the browser to be deleted text. This will
show the user that the on-screen text is understood to be deleted from the document (also for contract
documents). Selecting the Deleted Text menu item after selecting text in the current document will result in
the highlighted text being surrounded by the DEL tag.

Tag: <DEL> text </DEL>

EMPHASIS - (Sometimes used)
This inserts the HTML tag to emphasize text. The standard emphasized text is equivalent to bolded text.
Selecting the Emphasis menu item after selecting text will surround that text with the EM tag.

Tag: <EM> text </EM>

FOOTNOTE - (Sometimes used)
This logical tag modifies surrounded text so it is recognized by the browser to be a footnote. Selecting the
Footnote menu item after selecting text in the current document will result in the highlighted text being
surrounded by the FN tag.

Tag: <FN> text </FN>

INLINE QUOTE - (Rarely used)
This logical tag modifies surrounded text so it is recognized by the browser to be a short quotation used
within a paragraph. This differs from blockquotes in that blockquotes are set apart from the rest of the text
as complete paragraphs themselves. Selecting the Inline Quote menu item after selecting text in the current
document will result in the highlighted text being surrounded by the Q tag.

Tag: <Q> text </Q>

INSERTED TEXT - (Rarely used)
This logical tag modifies surrounded text so it is recognized by the browser to be inserted text. This is
useful for showing text that has been inserted into an original document, such as a contract. Selecting the
Inserted Text menu item after selecting text in the current document will result in the highlighted text being
surrounded by the INS tag.

Tag: <INS> text </INS>

KEYBOARD - (Sometimes used)
This inserts the HTML tag to display a keyboard key. Selecting the Keyboard menu item after selecting
text will surround that text with the KBD tag.

Tag: <KBD> text </KBD>

NOTE - (Rarely used)
This logical tag modifies surrounded text so it is recognized by the browser to be an important note,
warning, etc. This is useful for showing warning messages or cautions to get a reader's attention.
Selecting the Note menu item after selecting text in the current document will result in the highlighted text
being surrounded by the NOTE tag.

Tag: <NOTE> text </NOTE>
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PERSON - (Rarely used)
This logical tag modifies surrounded text so it is recognized by the browser to be the name of a person.
This is used to specify the name of a person, possibly for indexing programs, search programs, or linking
to another person's site. Selecting the Person menu item after selecting text in the current document will
result in the highlighted text being surrounded by the PERSON tag.

Tag: <PERSON>text </PERSON>

SAMP - (Sometimes used)
This logical tag modifies surrounded text so it is recognized by the browser to be sample output (example
text). Selecting the Sample menu item after selecting text in the current document will result in the
highlighted text being surrounded by the Samp tag.

Tag: <SAMP> text </SAMP>

STRONG - (Sometimes used)
This inserts the HTML tag to give text the stronger emphasis characteristic. Selecting the Strong menu
item after selecting text will surround that text with the STRONG tag.

Tag: <STRONG>text </STRONG>

VAR - (Sometimes used)
This logical tag modifies surrounded text so it is recognized by the browser to be the name of a variable.
Selecting the Variable menu item after selecting text in the current document will result in the highlighted
text being surrounded by the VAR tag.

Tag: <VAR> text </VAR>
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Physical Style Tags

Physical style tags are used to alter/enhance the appearance of the text in a Web document. They provide a
simple way to format text characters for effective documents. See below for descriptions of each physical
style tag.
______________________________________________________________________________

• Bold - <B></B>
• Italic - <I></I>
• Strikethrough - <S></S> [HTML 3.0]
• Subscript - <SUB></SUB> [HTML 3.0]
• Superscript - <SUP></SUP> [HTML 3.0]
• Typewriter Text - <TT></TT>

______________________________________________________________________________

BOLD - (Frequently used)
This inserts the HTML tag to make text appear bold. Selecting the Bold menu item after selecting text will
surround that text with the BOLD tag.

Tag: <B> text </B>

ITALIC - (Frequently used)
This inserts the HTML tag to make text appear in italics. Selecting the Italic menu item after selecting text
will surround that text with the I tag.

Tag: <I> text </I>

STRIKETHROUGH - (Sometimes used)
This inserts the HTML tag to strike a line through the selected text. Selecting the Strikethrough menu item
after selecting text will surround that text with the S tag.

Tag: <S> text </S>

SUBSCRIPT - (Sometimes used)
This inserts the HTML tag to display the selected text as subscript. Selecting the Subscript menu item
after selecting text will surround that text with the SUB tag.

Tag: <SUB> text </SUB>

SUPERSCRIPT - (Sometimes used)
This inserts the HTML tag to display the selected text as superscript. Selecting the Superscript menu item
after selecting text will surround that text with the SUP tag.

Tag: <SUP> text </SUP>

TT - (Sometimes used)
This inserts the HTML tag to represent text in the typewriter font. Selecting the Typewriter Text menu
item after selecting text will surround that text with the TT tag.
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Tag: <TT> text </TT>

UNDERLINE - (Frequently used)
This inserts the HTML tag to make text appear underlined. Selecting the Underline menu item after
selecting text will surround that text with the U tag.

Tag: <U> text </U>
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Math Tags

Math tags are essential in creating technical Web documents. They provide a way to represent different
mathematical expressions and variables which broaden the scope of the World Wide Web. Currently,
Math tags are not supported by most browsers.See below for descriptions of each element tag:
______________________________________________________________________________

• Above - <ABOVE></ABOVE> [HTML 3.0]
• Array - <ARRAY></ARRAY> [HTML 3.0]
• Atop - <ATOP> [HTML 3.0]
• Below - <BELOW></BELOW> [HTML 3.0]
• Box - <BOX></BOX> or {} [HTML 3.0]
• Choose - <CHOOSE></CHOOSE> [HTML 3.0]
• Item - <ITEM> [HTML 3.0]
• Math - <MATH></MATH> [HTML 3.0]
• Over - <OVER> [HTML 3.0]
• Root - <ROOT>#<OF></ROOT> [HTML 3.0]
• Row - <ROW> [HTML 3.0]
• Square Root - <SQRT></SQRT> [HTML 3.0]
• Subscript - _ _ or <SUB></SUB> [HTML 3.0]
• Superscript - ^ ^ or <SUP></SUP> [HTML 3.0]
• Text - <TEXT></TEXT> [HTML 3.0]
• Upright Font - <T></T> [HTML 3.0]
• Upright Bold Font - <BT></BT> [HTML 3.0]

______________________________________________________________________________

ABOVE - (Rarely used)
This HTML tag identifies the text it surrounds as the numerator of an expression (as in a fraction).

Tag: <ABOVE>math expression </ABOVE>

ARRAY - (Rarely used)
This HTML tag is used to form an array or matrix of items,variables, or expressions. All elements/items
of the array must be surrounded by these beginning and ending ARRAY tags.

Tag: <ARRAY>array rows and items </ARRAY>

Normally the code for an array with rows and items will appear like the following:
Tag: <ARRAY>

<ROW><ITEM>item <ITEM>item <ITEM>item
<ROW><ITEM>item <ITEM>item <ITEM>item
<ROW><ITEM>item <ITEM>item <ITEM>item

</ARRAY>

ATOP - (Rarely used)
Used between math expressions. This is useful for specifying that an expression is to be placed above
another expression, but no line is to be drawn between them (unlike a fraction). See the <OVER> tag.
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Tag: math expression <ATOP>math expression

BELOW - (Rarely used)
This HTML tag identifies the text it surrounds as the denominator of an expression (as in a fraction).

Tag: <BELOW>math expression </BELOW>

BOX - (Rarely used)
This is used to group math expressions together in order to include them in operations and exclude others.
Notice that there are two different HTML tags that are used to 'box' or group math expressions together.
Brackets can also be used. These brackets are invisible on-screen when browsing. They are particularly
useful when trying to specify which math variables/symbols are included in a numerator and which are
included in the are included in the denominator.

Tag: <BOX>math expression </BOX>
Also, {}

For example, 5 * <BOX> x <OVER> y </BOX> +2
will result in 5* x/y +2 but there will be no brackets/parentheses visible on-screen.

CHOOSE - (Rarely used)
This attribute encloses math expressions within parentheses (on-screen).

Tag: <CHOOSE>math expression </CHOOSE>

ITEM - (Rarely used)
This HTML tag denotes an item within a row within an array.

Tag: <ITEM>array item/math expression

MATH - (Rarely used)
The <MATH> tags surroundall math formulas, expressions, etc. Browsers need math expressions to be
surrounded by this tag in order to interpret the code as math expressions.

Tag: <MATH>all math expressions </MATH>

OVER - (Rarely used)
Used between math expressions. This is useful for specifying that an expression is to be placed above
another expression with a line drawn between them, like in a fraction. See the <ATOP> code.

Tag: math expression <OVER>math expression

ROOT - (Rarely used)
This tag specifies the root of the expression following it taken to the nth degree. The nth degree is specified
where the number sign lies between the <ROOT> and the <OF> in the following tag:

Tag: <ROOT>#<OF>math expression </ROOT>
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For example, the cube root of 1-x will be tagged like the following:
<ROOT>3<OF>1-x </ROOT>

ROW - (Rarely used)
This HTML code denotes a row within an array(matrix).

Tag: <ROW>array items

SQUARE ROOT - (Rarely used)
The text surrounded by this tag is displayed as the square root of the enclosed expression.

Tag: <SQRT>math expression </SQRT>

For example, the square root of 1+x will be tagged like the following:
<SQRT>1+x </SQRT>

SUBSCRIPT - (Rarely used)
Used to represent subscripted characters. Also use the underscore _ _ as an equivalent HTML tag. For
example, x<SUB>0</SUB> and x_0_ both represent x sub zero.

Tag: <SUB>math expression </SUB>
Also: _math expression _

SUPERSCRIPT - (Rarely used)
Used to represent superscripted characters. Also use the caret ^ ^ as an equivalent HTML tag. For
example, x<SUP>2</SUP> and x^2^ both represent x squared.

Tag: <SUP>math expression </SUP>
Also: ^ math expression ^

TEXT - (Rarely used)
Used to include text within a math element.

Tag: <TEXT>text </TEXT>

UPRIGHT FONT - (Rarely used)
Used to change the appearance/formatting of text, symbols, and variables within math elements. Upright
font is a 'non-italic' font. Variables are usually rendered in an italic font.

Tag: <T>math expression </T>

UPRIGHT BOLD FONT - (Rarely used)
Used to change the appearance/formatting of text, symbols, and variables within math elements. Upright
font is a 'non-italic' font. This tag changes the formatting of text/symbols within math elements to an
upright bold font(non-italic).

Tag: <BT>math expression </BT>
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CHAPTER 9

Web Weaver Tips

This chapter includes helpful tips to make your Web page experience easier. The
following tips are included:

• How to upload your Web page to the Web
• Helpful Web sites
• Web Weaver Shortcut Keys
• Troubleshooting
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How to Upload your Web page to the Web

OK, so you've created your Web page and it looks great, but now you want to put it on the Web for
everyone to see! Well, there are a few things you need in order to do this:

1) You need an Internet Service provider (ISP) or online service (like AOL) that provides you with some
Web disk space on their Web server.

2) You may need an FTP client program (WS_FTP is a program that we recommend) for uploading
(transferring files from your computer to the Web disk space on your ISP's Web server) the Web page and
images to your Web disk space. You probably don't need this if you are using AOL. AOL has a built in
program for transferring files.

3) If you have an ISP other than AOL, then you will have to know the name of the ISP's FTP server(e.g.,
ftp.yourisp.com), possibly the name of the directory that contains your Web disk space
(e.g.,/yourusername), your username and your password.

AOL USERS

Go to keyword MYPLACE and there are instructions there for uploading your Web page and images to
your AOL Web disk space.

OTHER ISP USERS

Find out all the information from your ISP listed in step 3 above. You will need to input it into the FTP
client program in order for it to be able to log into your ISP's FTP server.

When you are ready to upload your files, you must establish your connection to your ISP by dialing in as
you would normally do when checking email or surfing the Web.

Once you are logged in, run the FTP client program and connect to your ISP's FTP server (you should
already have input all the information that the FTP client needed to login, see item #3 above). If you
successfully connect, you should see two window panes in the FTP client program. One pane lists all the
files on your computer's local hard disk, the other shows all the files in your Web disk space on your ISP's
FTP server.

Now transfer files from your computer to the FTP server by selecting files in the local window pane
(showing your files) that you wish to upload. Then click on the transfer button (sometimes has an arrow on
it to show you which direction the files are being transferred).

NOTE: For Web pages (text documents) you should make sure you have selected the ASCII format for
transferring(not BINARY format).
For Images you must choose the BINARY format for transferring them.

Select the correct formats for each file BEFORE transferring them to and from your FTP server.
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If everything goes smoothly, then you should be able to view your Web page on the Web. If not, consult
with your ISP and ask them if you are doing anything incorrectly.
Your ISP should also know what the Web address (URL) is for your Web page. The URL is the address
you type into your browser to load a Web page, like http://www.mcwebsoftware.com

Helpful Web Sites

Below is a list of helpful Web sites which provide manuals on HTML authoring, advanced authoring, and
sites which provide extras such as backgrounds, horizontal rules, etc.

WebReference
http://www.webreference.com

WebMonkey
http://www.webmonkey.com

HTML Goodies
http://www.htmlgoodies.com

Introduction to HTML Documentation:
http://www.utirc.utoronto.ca/HTMLdocs/NewHTML/intro.html

Information on creating Web Sites:
http://home.mcom.com/assist/net_sites/index.html

Information on creating High Impact Documents:
http://home.mcom.com/assist/net_sites/impact_docs/index.html

HTML Quick Reference Guide:
http://www.ucc.ie/~pflynn/books/htmlcard.html

The WWW Consortium (straight from the horse's mouth):
http://www.w3.org/

Netscape Tables:
http://home.mcom.com/assist/net_sites/tables.html

Fill-In Forms in HTML:
http://utirc.utoronto.ca/HTMLdocs/NewHTML/forms.html

Common Gateway Interface: Forms:
http://hoohoo.ncsa.uiuc.edu/docs/cgi/forms.html

THE Netscape Frames Tutorial:
http://www.newbie.net/frames/index.html

http://www.mcwebsoftware.com


Page 125

125

Shortcut Keys

Below is a list of shortcut keystrokes you can use to make programming HTML much easier in Web
Weaver:

F1 Context Sensitive Help
Shift-F1 Heading 1
Shift-F2 Heading 2
Shift-F3 Heading 3
Shift-F4 Heading 4
Shift-F5 Heading 5
Shift-F6 Heading 6

F2 Colorize HTML tags (Web Weaver 97 only)
F3 Find Again
F4 Opens Browser #1 to view document
F5 Opens Browser #2 to view document
F6 HTML Stripper
F7 Image Mapping Software
F8 FTP Client
F9 Repeat Last Command

Cntrl-B Bold
Cntrl-I Italic
Cntrl-U Underline

Cntrl-F1 Subscript
Shift-Cntrl-F1 Superscript
Cntrl-E Center tag
Cntrl-K Line Break tag
Cntrl-L List item tag
Cntrl-H Horizontal Rule
Cntrl-O File Open
Cntrl-P Paragraph
Cntrl-N Inserts a non-breaking space character (&nbsp;)

Cntrl-T Inserts <TABLE></TABLE> tags
Cntrl-R Inserts <TR></TR> tags
Cntrl-D Inserts <TD></TD> tags

Cntrl-C Copy
Cntrl-X Cut
Cntrl-V Paste
Cntrl-A Select All
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Troubleshooting

Below are some problems that you might run into. Also check out our Web site for more troubleshooting
and frequently asked questions athttp://www.mcwebsoftware.com/s upport.html

Why doesn't Link to Browser work?
Make sure the Browser path and filename is specified correctly in the Preferences section (under
View/Preferences in the pull-down menus). You can select the appropriate Web browser by
clicking on the Browse button next to the Browser #1 or Browser #2 input text box. A
file/directory dialog box will appear and you will need to search for your Web browser's
executable file (iexplore.exe for Internet Explorer and netscape.exe for Netscape Navigator).
When you find the correct executable file in the Netscape or Internet Explorer directory then you
can select it and click 'OK'. The path and filename should be entered into the text input box
automatically. In Windows 95, Web Weaver may not recognize the path/filename of your browser
if the path consists of a large number of characters. Try to keep the paths short in length.

Why does Web Weaver open a new browser window each time I press Link to Browser?
This only occurs if you are using a browser other than Microsoft's Internet Explorer or Netscape's
Navigator.

Why can't Web Weaver find my WEBWEV.INI file?? (Web Weaver for Windows 3.1x only)
The WEBWEV.INI file could be in a different directory than the Web Weaver program file. In order for

the program to find the INI file, they must be in the same directory AND they cannot be in the root
directory together.

http://www.mcwebsoftware.com/support.html

